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CAUTION!

AFT Arrow is a sophisticated pipe flow analysis program designed for
qualified engineers with experience in pipe flow analysis and should not
be used by untrained individuals. AFT Arrow is intended solely as an
aide for pipe flow analysis engineers and not as a replacement for other
design and analysis methods, including hand calculations and sound
engineering judgment. All data generated by AFT Arrow should be
independently verified with other engineering methods.

AFT Arrow is designed to be used only by persons who possess a level
of knowledge consistent with that obtained in an undergraduate
engineering course in the analysis of pipe system fluid mechanics, have
been trained in the specialized field of gas dynamics, and are familiar
with standard industry practice in pipe flow analysis.

AFT Arrow is intended to be used only within the boundaries of its
engineering assumptions. The user should consult the AFT Arrow Help
System for a discussion of all engineering assumptions made by AFT
Arrow.

Information in this document is subject to change without notice. No part of this Quick
Start Guide may be reproduced or transmitted in any form or by any means, electronic or
mechanical, for any purpose, without the express written permission of Applied Flow
Technology.
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CHAPTER

1

Introducing AFT Arrow

Welcome to AFT Arrow™ 7, Applied Flow Technology's powerful
compressible pipe flow modeling tool. With AFT Arrow you can model
compressible flow in complex pipe networks, and include the
complicating effects of real gas behavior, heat transfer, gas mixing, and
sonic choking at one or more locations. In addition, it includes steam
property calculation from the most respected source, the ASME Steam
Tables. These capabilities will allow you to properly understand the
behavior of your gas system.

AFT Arrow performs a complete mass, momentum and energy balance
on your pipe system. It implements a sophisticated solution engine that
marches down pipes, offering superior accuracy to commonly used
lumped methods. The engineer accesses these capabilities through an
advanced graphical interface.

AFT Arrow 7 has two available add-on modules, which extend AFT
Arrow’s extensive modeling capabilities into new areas.

e The Goal Seek & Control (GSC) module allows the engineer to
perform multi-variable goal seeking and simulate control system
functions.

e The Automated Network Sizing (ANS) module automates the
process of sizing pipes and ducts in a complex network based on
required conditions, such as maximum pressure or minimum
flow, to reduce cost or weight.

AFT Arrow is a proven tool which provides the engineer with an
extremely broad and powerful feature set ready to tackle the most
demanding analysis problems.
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Modeling capabilities

AFT Arrow can be used to model a wide variety of compressible flow
systems. AFT Arrow consists of the standard version plus two optional
add-on modules.

AFT Arrow 7 capabilities

e Open and closed (recirculating) systems

e Network systems that branch or loop, with no limit on the number of
loops

e Pressure-driven systems

e Compressor or fan-driven systems, including multiple
compressor/fans in parallel or in series

e Compressor/fans with variable speed, controlled pressure, controlled
flow, and a fixed compression ratio

e Systems with pressure and/or flow control valves

e Systems with valves closed and compressor/fans turned off
e Heat transfer analysis and system energy balance

e Systems with non-ideal gases

e Systems that experience sonic choking, including multiple sonic
choking points

e Systems with non-reacting flow stream mixing and user-defined
mixtures with NIST REFPROP (or with optional Chempak)

e Systems with elevation changes or rotation such as in
turbomachinery

Add-on module capabilities

e Multi-variable goal seeking and control simulation (GSC)

e Automated design of piping networks (ANS)

AFT Arrow provides hundreds of standard loss models for pipe system
components, but also allows you to enter your own loss data. Variable
loss models that depend on flow are supported.
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AFT Arrow provides two independent solution methods that can be run
individually or in combination with each other to allow flexibility and
cross-verification of results. In addition, AFT Arrow offers two lumped
methods that offer improved computation speed with a slight loss in
accuracy. Modeling of low to high pressure and low to high velocity
systems can be performed. Sonic capabilities allow modeling of high
velocity conditions such as in relief systems.

AFT Arrow can model a large range of gas systems including steam,
natural gas, air, and chemical and petrochemical process gases. Support
for real gases is offered through several generalized equation-of-state
models, ASME Steam tables, NIST REFPROP, or the optional Chempak
add-on.

Thermophysical property data

AFT Arrow derives physical properties from one of four sources. The
first is the standard AFT Arrow set of gases which contains data for 28
common gases (called AFT Standard). The AFT Standard set is user
customizable, but does not support gas mixing.

The second option is the ASME Steam database. ASME Steam offers
improved accuracy on steam calculations with a corresponding increase
in model run time.

The third option is the NIST REFPROP database, first introduced in AFT
Arrow 7. NIST REFPROP is licensed from the National Institute of
Standards and Technology and is included in AFT Arrow. NIST
REFPROP has a database of approximately 150 fluids.

The fourth option is the Chempak™ database. Chempak is licensed from
Madison Technical Software and is offered as an optional add-on to AFT
Arrow 7. Chempak has a database of approximately 600 gases.

NIST REFPROP and Chempak support gas mixing in two forms. First,
users can create their own mixtures. These are called static mixtures and
are defined before the model is run. Second, as flow streams of different
composition mix, an entirely new gas mixture results. Its composition
depends on the composition of the incoming streams as well as the
relative flow rates. Since in general the flow rates are not known by the
user, AFT Arrow updates the composition of this new mixture as the
simulation progresses. For this reason, these mixtures are referred to as
dynamic mixtures. AFT Arrow is restricted to non-reacting gas mixture
calculations.
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Engineering assumptions in AFT Arrow
AFT Arrow is based on the following fundamental fluid mechanics
assumptions:
e Compressible flow
e All gases are superheated
e Steady-state conditions
e One-dimensional flow
e No chemical reactions
e Supersonic flow does not exist in the system

AFT Arrow allows you to change the gravitational acceleration of the
system, a feature useful for aerospace vehicle applications or pipe
systems that are designed for extraterrestrial environments.

AFT Arrow Primary Windows

The AFT Arrow window has five subordinate windows that work in an
integrated fashion. Each is located on a separate, moveable tab. You
work exclusively from one of these windows at all times. For this reason,
they are referred to as Primary Windows.

Of the five Primary Windows, two are input windows, two are output
windows, and one displays output and input information. Figure 1.1
shows the relationship between the Primary Windows.

Model Data

Visual Report

L

Y

Graph Results

Y

Workspace Output

Y

Figure 1.1 Primary Window workflow in AFT Arrow
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Input windows

The two windows that function exclusively as input windows are the
Workspace window and the Model Data window. These two windows,
one graphical and the other text-based, work together to process model
input data with immense flexibility. The tools that are provided in these
two windows allow you to model a large variety of pipe networks.

The Visual Report window can function in support of both input and
output data. As an input window, it allows you to see the input data
superimposed on the pipe system schematic created on the Workspace.

Output windows

The two windows that function exclusively as output windows are the
Output window and the Graph Results window. The Output window is
text-based, while the Graph Results window is graphical. These two
windows offer a powerful and diverse range of features for reviewing
analysis results for modeling errors, gaining a deeper understanding of
the pipe system's flow behavior, and preparing the results for
documentation.

As an output window, Visual Report allows you to see the output results
superimposed on the pipe system schematic created on the Workspace.

The five Primary Windows form a tightly integrated, highly efficient
system for entering, processing, analyzing, and documenting
compressible flow analyses of pipe networks.

Note: AFT Arrow will support dual monitors. You can click and drag
any of the five Primary Window tabs off of the main Arrow window.
Once you drag one of the Primary Windows off of the Arrow window,
you can move it anywhere you like on your screen, including onto a
second monitor in a dual monitor configuration. To add the Primary
Window back to the main Arrow primary tab window bar, simply click
the X button in the upper right of the Primary Window.
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CHAPTER 2

Topics covered

Flow Through an Orifice
Example

This chapter is intended to give you the big picture of AFT Arrow’s
layout and structure. Some of the more basic concepts will be used to
build a system to analyze the flow through an orifice.

A number of other example model discussions are included in a Help file
distributed with AFT Arrow called ArrowExamples.chm. It can be
opened from the Help menu by choosing "Show Examples" and selecting
“English Units”.

This example demonstrates a sample calculation to determine the
maximum flow through a system where sonic choking occurs.

This example will cover the following topics:

e Model building basics

e Entering pipe and junction data

e Specifying System Properties and Solution Control
e Specifying Output Control

e Creating Visual Reports

e Graphing results



8 AFT Arrow 7 Quick Start Guide

Required knowledge

Model file

No prior knowledge is required for this example.

This example uses the following file, which is installed in the Examples
folder as part of the AFT Arrow installation:

o  Orifice Flow.aro - AFT Arrow model file

This example is provided in the model file under the English Units
scenario. It is also provided in metric units under the Metric Units
scenario.

This example will require you to build the model from scratch to help
familiarize yourself with the steps required to build a complete model in
AFT Arrow. Therefore, use this example model file as a reference only.

Problem statement

For this problem, steam flows from one tank to another, through an
orifice.

The first pipe from the inlet tank to the orifice is 10 feet long and the
second pipe leading from the orifice to the discharge tank is 20 feet long.
Both pipes are Steel - ANSI, 2 inch, STD (schedule 40), and they are
very well insulated (adiabatic).

The inlet tank has a pressure of 250 psig, and a temperature of 500 deg. F
and is at an elevation of 0 feet. The discharge tank has a pressure of 0
psig and is at an elevation of 0 feet.

The orifice at the end of the first pipe has an area of 3 inches” and a K
factor of 10.

Determine the following:
1. What is the maximum flow through the system?
2. What is the sonic (stagnation) pressure at the exit?

3. At the maximum flow, what is the sonic area at the orifice? At
the discharge tank?
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Step 1. Start AFT Arrow

>

Review or
Modify Modeling
Preferences

To start AFT Arrow, click Start on the Windows taskbar, choose All
Programs, then AFT Products, and then AFT Arrow. (This refers to the
standard menu items created by a setup. You may have chosen to specify
a different menu item).

As AFT Arrow is started, the Arrow Startup window appears, as shown
in Figure 2.1. This window provides you with several options you can
choose before you start building a model.

M

OPEN A MODEL START A NEW MODEL RESOURCES

My Files Activate Modules (license needed) User Setup

[] GSC (Goal Seek & Control)
[ ANS (Automated Network Sizing)

Check for Latest Release
You are Currently Using
Version 7

Select Working Fluid Subscribe to Receive Mofifications

@® | Will Select Fluid Later
O Use AFT Standard "Air"
O Select A Recently Used Fluid

Quick Start Guides

Open PDF Guide (US) (Metic)
AFT: Air
Watch Video (intemet)  (US) (Metic)

\ Help Files
Open Help File (US & Metic)

Other Files Modeling Preferences OpenExampleHelp  (US) (Metic)

File with Descriptions

Units: All US and Metric units (US defaults)
Language: English

Browse to a File.. Interface: 2-D workspace, grid notshown Video Tutorials

Default Pipe Material: None

Show List of Available Online
Video Tutorials (intemet)

Browse to Examples..

Start Building Model

[ Dont Show This Startup Window Again

Figure 2.1 Startup Window with Modeling Preferences Collapsed

Some of the actions available are:

e Open a recent model, browse to a model, or browse to an Example
e Activate an Add-on Module

e Select AFT Standard Air or a recently used fluid

¢ Review or modify Modeling Preferences

e Select a Unit System
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e Filter units to include Common Only or Common Plus Selected
Industries

e Choose a Grid Style
e Select a Default Pipe Material

e Access other Resources, such as Quick Start Guides, Help Files, and
Video Tutorials

If this is the first time that you have started AFT Arrow, Modeling
Preferences will be expanded in the middle section of the Startup
Window, as shown in Figure 2.2. If this is not the first time that you have
started AFT Arrow, the Startup Window will appear with Modeling
Preferences collapsed, as shown in Figure 2.1.

When collapsed, you can view your current Modeling Preferences at the
bottom of Start a New Model. To further review or adjust your
preferences, click the “Modify>>" button (see Figure 2.1).

START A NEW MO MODELING PREFERENCES RESOURCES

Activate Modules (license needed) User Setup
[0 GSC (Goal Seek & Control) Uk Systeen Check for Latest Release
[ ANS (Automated Network Sizing) O s Only @® Both with US Defauits You are Currently Using:
O Metric Only O Both with Metric Defautts Vassion'?
Fitter
Select Working Fluid @ Al Units Subscribe to Receive Notifications
- (O Common Only
8 I Will Select Fluid Later O Common Plus Selected Industries Quick Start Guides
Use AFT Standard "Air”
O Select A Recently Used Fluid Buctiog Conprested 1% : :
Procing Open PDF Guide (US) (Metric)
AFT: Air sl ) )
Watch Video (internet)  (US) (Metric)
“* Show Sample Units "*
Help Files
Language
9529 Open Help File (US & Metric)
2D
Modeling Preferences Open Example Help  (US) (Metric)
Pipe Material File with Descriptions
Units: All US and Metric units (US defaults) p
Language: English
'D ;nP;;D k: e grid notsh Video Tutorials
elaul Matenial: None
Show List of Available Online
Video Tutorials (internet)
Start Building Model Note: For complete preferences, select User Options from the Tools menu
Remember My Preferences and Hide Discard and Hide

[ Dont Show This Startup Window Again

Figure 2.2  Startup Window with Modeling Preferences Expanded
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With Modeling Preferences expanded, as in Figure 2.2, select “Both with
US Defaults” under Unit System. Select “Common Only” under Filter to
show only commonly used units, instead of “All Units.”

You can “Show Sample Units” to see which units will be included based
on your selections, as shown in Figure 2.3.

MODELING PREFERENCES

Units Py

(- Pressure Units X
- Mass Flow Rate Units s

(- Volumetric Flow Rate Units
: Defaults

i~ gal/min
i liter/hr
i liter/min

T

t- Length Units lumy
t-- Diameter Units
t-- Density Uniis

T

[l

‘ wv Hide Sample Units vv |

Language

2D or Isometric Workspace

Pipe Maternial

Mote: For complete preferences, select User Options from the Tools menu

Remember My Preferences and Hide Discard and Hide

Figure 2.3  Show Sample Units with “Common Only” Selected

The other Filter option is “Common Plus Selected Industries,” which will
add units from the industries that you select. Once you have finished
modifying your Modeling Preferences, click “Remember My Preferences
and Hide.” Now that your unit preferences are set, click “Start Building
Model.”
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The Workspace window is the initial active (large) window, as seen in
Figure 2.6. The five tabs in the AFT Arrow window represent the five
primary windows. Each Primary Window contains its own toolbar that is
displayed directly beneath the Primary Window tabs.

The Workspace window

The Workspace window is the primary vehicle for building your model.
This window has three main areas: the Toolbox, the Quick Access Panel,
and the Workspace itself. The Toolbox is the bundle of tools on the far
left. The Quick Access Panel is displayed on the far right. It gives easy
access to a variety of features such as the Scenario Manager, the
Checklist Panel, and viewing pipe and junction properties. The
Workspace takes up the rest of the window.

A5 AFT Arrow - Untitled (Workspace)

Base Scenario

- m] *
Eile Edit Mew Analysis Tools Database Amange Window Help ‘
S G| B3T3 | 5 & | Search | b ’ ‘
/" Workspace | % Model Data | [T Output | 2 Graph Results | ® Visual Report Scenario Manager
P Hi | e =R = e g bl - = ek | E
« 4 & -4 Base Scenario
=S Primary Window Tabs  Quick Access Panel
oL ick A P | Pi
> 6 Float Toolbox Quick Access Panel Pin
= Scenario Manager in Notes
Quick Access Panel
W = Toolbox
Ml
t O Checklist Panel
Workspace .
o= Workspace =2 Propertes
D - Overview Map Check List
= Workspace o Speciy Soluion Cortrol
@ StatUS Bal’ Z -pl- | W Specify System Properties
ESiln oom Tools

¥ Define All Pipes and Junctions
Specify Cost Settings

«f CheckList

B2 | &, 100% | (=) [} (#|=0 D0

Figure 2.4 The Workspace window is where the model is built.
The other four Primary Windows are found on the tabs
along the top of the Workspace. The Status Bar shows
the model status

You will build your pipe flow model on the Workspace using the
Toolbox tools. At the top of the Toolbox is the Float Toolbar. From here,
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you can choose the location of the Toolbox in reference to the
Workspace by specifying Dock Left, Float, or Dock Right. Below the
Float Toolbar are two drawing tools. The Pipe Drawing tool, on the
upper left, is used to draw new pipes on the Workspace. Next to this tool
is the Annotation tool. The Annotation tool allows you to create
annotations and auxiliary graphics.

Below the two drawing tools are twenty icons that represent the different
types of junctions available in AFT Arrow. Junctions are components
that connect pipes, and influence the pressure or flow behavior of the
pipe system. The twenty junction icons can be dragged from the Toolbox
and dropped onto the Workspace.

When you hold your mouse pointer over any of the Toolbox tools, the
Toolbox tooltips identify the tool's function.

Unpinning the Quick Access Panel

By default, the Quick Access Panel is pinned to the Workspace window
so it is constantly displayed. The Quick Access Panel can be unpinned so
it is only displayed when the mouse is moved over the tab displayed on
the right edge of the Workspace window. Unpin the Quick Access Panel
by clicking on the picture of the pin displayed in the top right corner of
the Quick Access Panel (see Figure 2.4). For the remainder of the
examples in this guide, the Quick Access Panel will be unpinned.

Step 2. Lay out the model

To lay out the orifice flow model, you will place three junctions on the
Workspace. Then you will connect the junctions with pipes.

A. Place a tank

» To start, drag a Tank junction from the Toolbox and drop it on the
Workspace. Figure 2.5a shows the Workspace with one tank.

Objects and ID numbers

Items placed on the Workspace are called objects. All objects are derived
directly or indirectly from the Toolbox. AFT Arrow uses three types of
objects: pipes, junctions and annotations.

All pipe and junction objects on the Workspace have an associated ID
number. For junctions, this number is, by default, placed directly above
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the junction and prefixed with the letter “J”. Pipe ID numbers are
prefixed with the letter “P”. You can optionally choose to display either
or both the ID number and the name of a pipe or junction. You also can
drag the ID number/name text to a different location to improve
visibility.

The tank you have created on the Workspace will take on the default ID

number of 1. You can change this to any desired integer greater than zero
but less than 100,000.

Editing on the Workspace

Once on the Workspace, junction objects can be moved to new locations
and edited using the features on the Edit menu. Cutting, copying, and
pasting are all supported. A single level of undo is available for all
editing operations.

7" Workspace | §%Model Dats | [=10utput | [ Graph Results | %> Visual Report
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Figure 2.5a Walk through model with first junction placed

B. Place the other junctions

If the new junction type you want to add already exists on the
Workspace, you have the option of duplicating that junction. You do this
by choosing Duplicate from the Edit menu.
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Drag an Orifice junction from the Toolbox and drop it somewhere to the
right of the Tank junction (see Figure 2.5b). Then, either duplicate the
first tank, or drag a new Tank junction onto the Workspace. Place the
new tank somewhere to the right of the Orifice junction (see Figure
2.5b).

Note: The relative location of objects in AFT Arrow is not important.
Distances and heights are defined through dialog boxes. These relative
object locations on the Workspace establish the connectivity of the
objects, but have no bearing on the actual length or elevation
relationships. The Isometric Pipe Drawing Mode (see Chapter 3) can be
used to visually represent the three-dimensional nature of a system.

If the icons do not line up exactly, the calculations will not be affected.
However, your model may have a nicer appearance if the icons line up.
You can align the icons by using the align features selected from the
Arrange menu.

Y our model should now appear similar to that shown in Figure 2.5b.
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Figure 2.5b Walk through model with all junctions placed
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Before continuing, save the work you have done so far. Choose “Save
As” from the File menu and enter a file name (Orifice Flow, perhaps)
and AFT Arrow will append the “.aro” extension to the file name.

C. Draw a pipe between J1 and J2
Now that you have three junctions, you need to connect them with pipes.
» To create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The

pointer will change to a crosshair when you move it over the Workspace.
Draw a pipe below the junctions, similar to that shown in Figure 2.5¢.

The pipe object on the Workspace has an ID number (P1) that is shown
near the center of the pipe.

*Workspace | ¥ ModelData | [ElOutput | [ Graph Results | @ Visual Report
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Figure 2.5¢ Walk through model with first pipe drawn

» To place the pipe between J1 and J2, use the mouse to grab the pipe in
the center, drag it so that its left endpoint falls within the J1 Tank icon,
then drop it there (see Figure 2.5d). Next, grab the right endpoint of the
pipe and stretch the pipe, dragging it until the endpoint terminates within
the J2 Orifice icon (see Figure 2.5¢).
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Figure 2.5d Walk through model with first pipe partially connected
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Figure 2.5e Walk through model with first pipe connected
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Reference positive flow direction

There is an arrow on each pipe that indicates the reference positive flow
direction for the pipe. AFT Arrow assigns a flow direction corresponding
to the direction in which the pipe is drawn.

You can reverse the reference positive flow direction by choosing
Reverse Direction from the Arrange menu or selecting the reverse pipe
direction button on the Toolbar.

In general, the reference positive flow direction is used for reference
purposes only and need not be the actual flow direction. However, when
used with compressors/fans and certain other junction types, the pipes
must be in the correct flow direction because that is how AFT Arrow
determines which side is suction and which is discharge. If the reference
positive direction is the opposite of that obtained by the Solver, the
output will show the flow rate as a negative number.

D. Add the remaining pipe

A faster way to add a pipe is to draw it directly between the desired
junctions.

» Activate the Pipe Drawing Tool again, position the mouse pointer on
the J2 Orifice, then press and hold the left mouse button. Stretch the pipe
across to the J3 Tank, and then release the mouse button. Your model
should now look similar to Figure 2.5f.

At this point all the objects in the model are graphically connected. Save
the model by selecting Save in the File menu or by clicking on the
diskette button on the Main Toolbar.

Note: Some users find it desirable to lock objects to the Workspace once
they have been placed. This prevents accidental movement and
disruption of the connections. You can lock all the objects by choosing
Select All from the Edit menu, then selecting Lock Object from the
Arrange menu. The lock button on the Workspace Toolbar will appear
depressed indicating it is in an enabled state, and will remain so as long
as any selected object is locked. Alternatively, you can use the grid
feature and snap to grid. The grid options can be modified through the
User Options window from the Tools menu.
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Figure 2.5f Walk through model with all pipes and junctions placed

Step 3. Complete the Checklist requirements

» Next, click the checkmark on the Toolbar at the top of the AFT Arrow
window. This opens the Checklist window (see Figure 2.6). The
Checklist window (also simply called the Checklist) contains four or
more items depending on which modules and features you may be using.
Each item needs to be completed before AFT Arrow allows you to run
the Solver.

The state of each Checklist item can also be seen by clicking the Model
Status light on the Status Bar at the bottom right corner of the AFT
Arrow window (see Figure 2.4). This will cause the Checklist to be
displayed in the Quick Access Panel window to the right of the
Workspace. The Checklist can also be opened from the View menu.
Once the Checklist is complete, the Model Status light in the lower right
corner turns from red to green.
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A. Specify solution control

The first Checklist item, Specify Solution Control, is always checked
when you start AFT Arrow because AFT Arrow assigns default solution
control parameters. In general, you do not need to adjust these values. If
necessary, you can make adjustments by opening the Solution Control
window from the Analysis menu.

Checklist
%  Specify Solution Control Close
¥ Specify System Properties Help
¥ Define All Pipes and Junctions
Specify Cost Settings

Figure 2.6  The Checklist window tracks the defined and
undefined model input

B. Specify system properties

The second item on the Checklist is Specify System Properties. To
complete this item, you must open the System Properties window. This
window allows you to select your fluid(s) as well as gravitational
acceleration and atmospheric pressure.

You can select a fluid from the standard AFT Arrow fluid database (AFT
Standard), select ASME Steam, select multiple fluids and/or create
mixtures using the Chempak database (an optional add-on to AFT
Arrow), or create custom fluids. Custom fluids are created by opening
the Fluid Database window from the AFT Arrow Database menu or by
clicking the Edit Fluid List button in the System Properties window.

» Select System Properties from the Analysis menu to open the System
Properties window (see Figure 2.7). For this example, use the AFT
Standard Database and select “Steam” in the upper list, then click the
“Add to Model” button. Leave the equation of state model as “Redlich-
Kwong” and the enthalpy model as “Generalized”.

» Open the Checklist once more or observe the Checklist Panel and you
should now see the second item checked off.
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C. Specify cost settings

Skipping the third Checklist item for the moment, the fourth Checklist
item, Cost Settings, is always deactivated when you start AFT Arrow.
The Cost Settings window provides a way to define energy costs, and the
types of costs to be included in the cost calculations. By default, the cost
calculation is turned off, and hence nothing further is required for this
Checklist item.

System Properties

FEluid Data System Data

Fuids Available in Database
(®) AFT Standard  (©) ASME Steam Tables (O Chempak () NIST REFPROP

Name o)
Oxygen (GO2)

Propane

Propylene

Refrigerant C-318

Steam

Suffur Dioxide v

v Addto Model v

Fluids in Currert Model Accuracy
Steam

Remove Fuid

Add to Database...

Specific Heat Ratio

(O Standard
Equation of State: | Redlich-Kwang ~ @ Database (O User ® High

Specific Heat Ratio Source

Erthalpy Model: | Generalized v

Edit Fluid List... QK Cancel Help

Figure 2.7 The System Properties window lets you select gases
for the model and create mixtures

Step 4. Define the model components (Checklist item #3)

The third item on the Checklist, “Define All Pipes and Junctions”, is not
as straightforward to satisfy as the other three. This item includes the
required input data and connectivity for all pipes and junctions.

Object status

Every pipe and junction has an object status. The object status tells you
whether the object is defined according to AFT Arrow's requirements. To
see the status of the objects in your model, click the light bulb icon on
the Workspace Toolbar (alternatively, you could choose “Show Object
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Status” from the View menu). Each time you click the light bulb, “Show
Object Status” is toggled on or off.

When “Show Object Status” is on, the ID numbers for all undefined
pipes and junctions are displayed in red on the Workspace. Objects that
are completely defined have their ID numbers displayed in black. (These
colors are configurable through User Options from the Tools menu.)

Because you have not yet defined the pipes and junctions in this sample
problem, all the objects’ ID numbers will change to red when you turn on
“Show Object Status”.

Showing undefined objects

Another useful feature is the Undefined Objects list (Figure 2.8). This
can be opened from the View menu by clicking on “List Undefined
Objects...” or by clicking on “Define All Pipes and Junctions” on the
Checklist. Here all objects with incomplete information are listed.
Clicking on an undefined pipe or junction will display the property data
that is missing. Click the Close button to stop showing this window.

=~ Undefined Pipes

1 Ppe |
2 Pipe

O Undefined Junctions

1 Tank
2 Orifice
3 Tank

& Undefined Properties for Pipe 1:

Pipe Length
Pipe Inner Diameter
Roughness/Friction

Save All... Copy All... Close

Figure 2.8  The Undefined Objects list lets you see the undefined
properties for each undefined object
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A. Define Tank J1

» To define the first tank, open the J1 Tank Properties window (Figure
2.9) by double-clicking on the J1 icon. The pipe table should show you
that Pipe 1 is connected to this tank (click the Loss Coefficients tab to
display the pipe table).

Note: You can also open an object's Properties window by selecting the
object (clicking on it) and then either pressing the Enter key, double-
clicking the object, or clicking the Open Pipe/Junction Window icon on
the Workspace Toolbar.

Tank Properties

Nmoer oK

Name: ‘ Inlet Tank ~ | Cancel
L Hevation

Database List: e Jump..

Copy Data From Jet... ~ D feet >

Help

Tank Mode| Loss Coefficients Optional Design Alerts Motes Status
Tank Condtions
Fluid: Steam ~

Pressure: psig ~
Temperature: deg. F ~

[[] Balance Energy in Tank

Figure 2.9 Properties window for Tank J1

> Enter a pressure of 250 psig. This tank will represent the supply tank
upstream of the orifice. You can assign any unit of pressure found in the
adjacent drop-down list of units. Enter a temperature of
500 degrees F and an elevation of 0 feet.
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Note: You can choose default units for many parameters (such as feet
for length) in the Tools/User Options window under Preferred Units.

You can give the component a name, if desired, by entering it in the
Name field at the top of the window. In Figure 2.9, the name of this tank
is Inlet Tank. By default, the junction’s name indicates the junction type.
The name can be displayed on the Workspace, Visual Report or in the
Output.

Most junction types can be entered into a custom database allowing the
junction to be used multiple times or shared between users. To select a
junction from the custom database, choose the desired junction from the
Database List in the junction’s Properties window. The current junction
will get the properties from the database component.

The “Copy Data From Jct...” list will show all the junctions of the same
type in the model. This will copy the user-selected parameters from a
specified existing junction in the model to the current junction.

Using the folder tabs in the Properties windows

The information in the Pipe and Junction Properties windows is grouped
into several categories (or folders) and placed on separate tabs. Click the
folder tab to bring its information forward. Figure 2.9 is an example of a
tank’s Properties window.

Click the Loss Coefficients folder tab in the Properties window of J1 to
show the pipe table. The pipe table allows you to specify entrance and
exit loss factors for each pipe connected to the tank (in this case there is
only one). The default selection is for the loss factors to be specified as
zero. To change the loss factors later, click within the pipe table and
enter the loss.

The Optional folder tab allows you to enter different types of optional
data. You can select whether the junction number, name, or both are
displayed on the Workspace. Some junction types also allow you to
specify an initial pressure and temperature guess, as well as other
junction-specific data.

Each junction has a folder tab for notes, allowing you to enter text
describing the junction or documenting any assumptions.

The highlight feature displays all the required information in the
Properties window in light blue. The highlight is on by default. You can
toggle the highlight off and on by double-clicking anywhere in the
window above the folder tabs or by pressing the F2 key. The highlight
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Inspection
window

feature can also be turned on or off by selecting “Highlight in Pipe and
Jet Windows” on the View menu.

Click OK. If “Show Object Status” is turned on, you should see the J1
ID number turn black again, telling you that J1 is now completely
defined.

The Inspection feature

You can check the input parameters for J1 quickly, in read-only fashion,
by using the Inspection feature. Position the mouse pointer on the J1 tank
icon and hold down the right mouse button. The inspection window
appears, as shown in Figure 2.10.

Inspecting is a faster way of examining the input in an object than
opening the Properties window.
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Figure 2.10 Inspecting from the Workspace with the right mouse
button

B. Define other junctions

» Next, open the Properties window for Orifice junction J2. Enter the

Orifice Type as User Specified, and the Subsonic Loss Model as constant
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K Factor. Enter the orifice area as 3 inches?, the K factor as 10, and the
elevation as 0 feet (see Figure 2.11).

» Open the J3 Tank junction and change the name to Discharge Tank.
Then enter a pressure of 0 psig, a temperature of 500 deg. F and an

elevation of 0 feet.

» Save the model again before proceeding.

Orifice Properties

MNumber: Upstream Pipe 1 oK
Downstream Pipe: 2
Name Orfice v
| | Blevation Cancel
Database List: ~ l:l = - =
Copy Data From Jet... ~

Help

Loss Model Optional Design Alerts Notes Status

Orffice Type Orffice Dimensions
() Shamp-Edged Connecting Pipe Geometry:
) Round-Edged Straight Pipe

Area Ratio, Orifice/Upstream
0.89403

Subsonic Loss Model Area Ratio, Orifice./Downstream:
0.83403

() Cd (Discharge Cosff.) @ Area () Diameter

o ey inches2 ~

(O Resistance Curve

(®) User Specfied

«

Basis Area for Loss Model

Upstream Pipe v Base Area from Pipe 1
0.023303 feet2 (D = 2.067 inches)
CdA ffor Sonic Choking - [] Exit Orifice (optional)
Optional)

deg. F

Figure 2.11 Properties window for Orifice J2

C. Define Pipe P1

Data for pipes and junctions can be entered in any order. In this example,
the junctions were done first. The next step is to define all the pipes. To
open the Pipe Properties window, double-click the pipe object on the
Workspace.

» First, open the Pipe Properties window for Pipe P1 (see Figure 2.12).
For Pipe P1 enter Steel - ANSI, 2 inch, STD (schedule 40), Standard
friction model, and a length of 10 feet.
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The Pipe Properties window

The Pipe Properties window offers control over all important flow and
heat transfer parameters that are related to pipes.

The Inspect feature can be accessed not only from pipes and junctions
located on the Workspace, but also from within the Properties window of
each pipe (and certain junctions). This is helpful when you want to
quickly check the properties of objects that connect to a pipe or junction
whose Properties window you already have open.

To Inspect a junction connected to a given pipe, position the mouse
pointer on the connected junction's ID number in that pipe’s Properties
window (located at the top right of the Pipe Properties window) and hold
down the right mouse button. This process can be repeated for any
junctions that state the upstream and downstream pipe in the junction’s
Properties window by holding the right mouse button on the pipe’s ID
number.

Pipe Properties

Number: Upstream Junction: 1 OK

T [Pee | Downstream Junction 2 Cancel

Copy Data From Pipe ~ Jump
Help
Pipe Model | Fittings & Losses  Heat Transfer DesignAlerts  Optional Notes Status

Size Length

Pipe Material: | Steel - ANSI ~ eet ~
Pipe Geometry: Cylindrical Pipe hid
Size: 2inch =
Type STD (schedule 40) ~
Iner Diameter: inches v
inches
inches
[ ID Reduction (Scaling):
Friction Model
DCat)a US:r Speciied Absolute Roughness ~ Load Default
@ [Standard v inches e

Figure 2.12 Properties window for Pipe P1

By double-clicking the connected junction number from a Pipe’s
Properties window, you can jump directly to the junction's Properties
window. Or you can click the Jump button to jump to any other part of
your model.
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D. Define Pipe P2

» Open the Properties window for Pipe 2 and specify Steel - ANSI, 2
inch, STD (schedule 40), Standard friction model, and a length of 20
feet. You will note that the pipe size and type is remembered from the
previous pipe (this can be configured in the User Options window under
Pipes and Junctions in the Parameters section). You can also choose the
“Copy Data From Pipe” dropdown and select the parameters from any
other pipe to apply to this pipe.

After completing Pipe 2, the Checklist should now be complete.
E. Check pipes and junctions

» Check if all the pipes and junctions are defined. If all data is entered,
the “Define Pipes and Junctions” Checklist item on the Quick Access
Panel will have a check mark. If not, turn on the “Show Object Status”
from the View menu, and open each undefined pipe and junction. The
Status tab on each Properties window will indicate what information is
missing.

F. Review Model Data

> Before running the model, save it to file one more time. It is also a
good idea to review the input using the Model Data window.

Reviewing input in the Model Data window

The Model Data window is shown in Figure 2.13. To change to this
window, you can click on the Model Data tab, select it from the Window
menu, or press Ctrl + M. The Model Data window gives you a text-based
perspective of your model. Selections can be copied to the clipboard and
transferred into other Windows programs, saved to a formatted file,
printed to an Adobe™ PDF, or printed out for review.

Data is displayed in three sections. The top is called the General data
section, the middle is the Pipe data section and the bottom is the Junction
data section. Each section is collapsible using the buttons at the top left
of the section. Further, each section can be resized.

The Model Data window allows access to all Properties windows by
double-clicking on any input parameter column in the row of the pipe or
junction you want to access. You may want to try this right now.
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Figure 2.13 The Model Data window shows all input in text form

Step 5. Run the Solver

» Choose “Run Model” from the Analysis menu or click the arrow icon
on the Main Toolbar. During execution, the Solution Progress window
displays (see Figure 2.14). You can use this window to pause or cancel
the Solver's activity. When the solution is complete, click the Output
button and the text-based Output window will appear (see Figure 2.15).
The information in the Output window can be reviewed visually, saved
to file, exported to a spreadsheet-ready format, copied to the clipboard,
printed to an Adobe PDF file, and printed out on the printer.
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Figure 2.14 The Solution Progress window displays the
convergence progress

Step 6. Review the output

The Output window (Figure 2.15) is similar in structure to the Model
Data window. Three areas are shown, and you can expand or collapse

each area by dragging the boundary between the areas up or down, or by
clicking the arrow beside the area label. The items displayed in the tables

are those items you choose in the Output Control window.
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MName Mass Wel. Vel Mach | Mach | dP Stag. | P Stag. | P Stag. | P Static | P Static dT T Stag. | TStag. | T Sk
Out #in | #O0ut | Total In o] Outlet

Junction Output

i: Warnings  Sonic Choking  Tank Summary

Execution Time= 0.11 seconds

Total Number Of Pressure fterations= 0
Total Number Of Flow fterations=3
Total Mumber Of Enthalpy herations=3
Number Of Pipes= 2

Number Of Junctions= 3

Matrix Method= Gaussian Elimination

<

P\Des Axial Points  Heat Transfer

Fipe Flow Rate In ut In Out Stag. Inlet In

~ (lbmisec)  (feet'sec) (feetisec) (psid) (psia) | (psia) (psia) (psia) | (deg. F) | (deg.F) | (deg. F) | (deg.
1 |Pipe 4646 4211 4400 02401 02506 1068 2647 2540 2555 24440 1710 5000 4983 &

2 |Pipe 4646 7434 16635 04223 0.5500 5637 15693 1030 1426 5730 15534 4819 4663 &

€ >

Section
All Junctions | Orifice  Tank
Name Mass Flow | dP Stag. | PStag. | P Stag. | P Static | P Static | dT TStag. | TStag. | T Static | T Static dH H

Jet Rate Thru Jct | Total In Out In Out Stag. Inlet Qutlet In Out Stag.
~ (lbmisec) (psid) | (psia) | (psia) | (psia) | (psia) | (deg.F) | (deg.F) | (deg. F) | (deg. F) | (deg.F) | (Btwlbm) | (Bt
1 |Inlet Tank 4846 000 2847 28470 2847 26470 000 5000 5000 5000 5000 ]
2 | Orifice 4646 9468 2540 15933 2444 14261 16.41 4383 4819 4913 4807 ]
3 | Discharge Tank 4646 8827 1030 1470 1030 1470 000 5000 5000 5000 5000 0
< >
Base Scenario/English Units/No Orifice CdA | | 100% '5' L) "i"

Figure 2.15 The Output window displays output in text form

This system chokes at the discharge tank. When a system chokes, Arrow
will display the "Sonic Choking" tab in the General Output section (see
Figure 2.16). This tab will appear when sonic choking occurs in the
system, and will contain messages pertaining to the sonic choking
conditions.

Because the flow is choked at the exit, the mass flow rate shown in the
output reflects the maximum flow rate through the system for the given
conditions. The maximum flow rate through this system is 4.646
Ibm/sec. The sonic pressure at the exit is 103 psia (i.e., stagnation
pressure at Pipe 2 outlet). The output in the junction data portion of the
Output window shows the Sonic Area at the orifice is 1.377 inches®, and
the Sonic Area at the discharge tank is 3.355 inches®. Since the system
chokes at the discharge tank, and the connecting pipe, P2, has no
restriction at the end, the sonic area is equal to the pipe physical area of
the 2 inch, standard schedule pipe.



32 AFT Arrow 7 Quick Start Guide

Q Model Data

i R A

,-‘J' Workspace B Output @ Graph Results

&> Visual Report

General Warnings | iS

Tank Summary

Sonic Choking Exists at Junction 3 (Discharge Tank)

<

Pipes | Axial Points  Heat Transfer
Name | Mass Wel. Wel. Mach | Mach | dP Stag. | P Stag. | P Stag. | P Static | P Static dT T5tag. | T5tag. | T 5ta
Pipe Flow Rate In Out #in | #0ut | Total In Out In Out Stag. Inlet Outlet In
(lbm/sec) | (feetisec) | (feetisec) (psid) | (psia) | (psia) | (psia) | (psia) | (deg.F) | (deg. F) | (deg.F) | (deg.
1 |Fipe 4 646 4211 4400 02401 02506 1068 2647 2540 2555 24440 1710 5000 4983  4F
2 |Fipe 4 646 7434 16635 04223 09900 5637 1593] 1030 | 1426 5730 15534 4819 4663  4f
£ >
All Junctions | Orifice  Tank
P Stag. | P Static | P Static | dT TStag. | T Stag. | T Static | T Static dH HStag. | HStag. | H Static | H Static | Sonic
Jet Qut In Out Stag. Inlet Outlet In Out Stag. In Out In Qut Area
(psia) | (psia) | (psia) | (deg.F) | (deg. F) | (deg. F) | (deg. F) | (deg. F) | (Btulbm) | (Btwlbm) | (Btwlbm) @ (Btwlbm) | (Btwlbm) | (inches2)
1F 26470 2647 26470 0.00 5000 5000 500.0 500.0 0 1257 1257 1257 1257
2 D 18833 2444 14281 16.41 4383 4819 4913 4607 0 1288 1,258 1254 1.247
3D 1470 1030 1470 0.00 5000 5000 500.0 500.0 0 1278 1278 1278 1.278

Figure 2.16 The Output window displays the Sonic Choking tab
whenever sonic choking occurs in the system

Step 7. Customize the output

The Output Control window (Figure 2.17) allows you to select the
specific output parameters you want in your output. You also can choose
the units for the output. If you do not change any of the Output Control

settings, default Output Control parameters and a default title are
assigned.

Select Output Control from the Tools menu or the Main Toolbar to
open the Output Control window (Figure 2.17). On the Display
Parameters tab, select the Pipes button. The list of selected pipe output
parameters will be displayed on the right hand side. If you selected the
default AFT Arrow Output Control, the pipe results in the Pipes table
will show mass flow rate in the second column with units of lbm/sec.
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Change the units for Mass Flow Rate by selecting kg/min (kilograms per
minute) from the unit list shown beside the parameter.

Output Control
? Reorder
Display Parameters = Genersl  Format& Action  Show PipesiJets  JctDeltas  Multi-Scenario OUtpUt
— . .
3 Ppss  1F Junctions | 4 Compressor/Fan | £ Valves | 4 Heat Exchangers ‘ L Tanks ‘ €23 Cost Repart | 9 Heat Transfer| l usi ng thls
Select the / Avalable Outpus Parameters Show Outpus in This Order Reorder tool
output type C— . | Parametsr Unis ~
Compressibility Factor Average Outlet (: 1 Name of Pipe “
Compressibility Factor Inlet > ;
These are Compressibilty Factor Outlet Average (; 1 Mass Flow Rate Ibmisec &
(C:Uncerilrdhun ualss FFractiun Other (4 Velocity Inlet feetisec ~
ancentration Mole Fraction - .
parameters [ty e 04 Velocity Outet feetisec ~
Conductivity Inlet ;4 Mach Number Inlet
that can be N Ggnductiviy Outit =+ | |3
A n Coef. Extemal G4 Mach Number Outlet These are
d|sp|ayed Convectio! emal Add (! Pressure Loss Stag. Total psid - \
Convection Coc/@veral o ) i
Density Stagnation Average G : Pressure Stagnation Inlet psia ~ \ d | Splayed
Density Stagnation Inlet (| Pressure Stagnation Outlet psia ~ A th
Ba"sg Shagnation Oufet 1 Pressure Static Inlet psia v In the
ensi ic Average o -
The para meters Density Static Inlet G| Pressure Static Outlet psia ~ Output
. Density Static Outlet CH T ture Loss Stagnat deg. F ~
can be viewed Design Factor £ -
. ign Factor Fittings & Losses - 3| Temperature Stagnation Inlet deg. F, ~
alphabetically or R > (21 Tempersiure Stegnaion Ouis A
b Cate or = A Tamnaratira Static Inlat Aan F e
! ow
y g y Alphabetical Description Remove Clear Al Same Units. Use Prefemed Units.. ~ Select
Output Window Table Header:  Flow Area u n Its
Visuzl Report Abbrevistion: A
Lo Description Pipe cross-sectional flow area
Description of
terms can be
displayed
Load Control Format.. User Default Amow Default OK
Same As Parent w Save Control Format: Set as Default Help Cancel

Figure 2.17 The Output Control window lets you customize the
output

Click OK to display changes to the current results. You should see

the mass flow rate results, still in the second column, in units of kg/min.
Notice the Velocity Inlet (Vel. In) results in the third column.

Select Output Control from the Tools menu one more time. Select the

Display Parameters tab, and select the Pipes button. The Reorder scroll
bar on the far right allows you to reorder the sequence of parameters that
will be displayed in the output. You can also click on the reorder symbol
on the left side of each row to manually drag-and-drop the rows to
change the parameter order (see Figure 2.17).

Select the Velocity parameter and use the Reorder scroll bar or drag-
and-drop to move it up to the top of the parameter list.

Click OK to display the changes to the current results. You will see

in the pipe results in the Pipes table that the first column now contains
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Vel. In (Velocity Inlet), the second column now contains the pipe name,
and the third column contains the mass flow rate. The Output Control
window allows you to specify the parameters, units and order of the
displayed parameters that you want to see in the output. This flexibility
will help you work with AFT Arrow in the way that is most meaningful
to you, reducing the possibility of errors.

Lastly, double-click the column header for Vel. In the Output
window in the pipe results in the Pipes table. This will open a window
in which you can change the units once again if you prefer (see Figure
2.18). These changes are extended to the Output Control parameter data
you have previously set.

Change Units

Velocity at pipe inlet

Vel In
[meters/zec)

cm./min s | QK |

CM/Sec
feet/day Cancel
fest/hr

feet/min
¥ | | Use Prefemed

Figure 2.18 The Change Units window is opened from the Output
window tables by double-clicking the column header

Step 8. View the Visual Report

» Change to the Visual Report window by clicking on the Visual Report

tab, choosing it from the Window menu, or pressing Ctrl + I. This
window allows you to integrate your text results with the graphic layout
of your pipe network.
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» Click the Visual Report Control button on the Visual Report
Toolbar (or Tools menu) and open the Visual Report Control window,
shown in Figure 2.19. Select Velocity Inlet in the Pipe Results area and
Pressure Static Inlet in the Junction Results area. Click the Show button.
The Visual Report window graphic is generated (see Figure 2.20).

It is common for the text in the Visual Report window to overlap when
first generated. You can change this by selecting smaller fonts or by
dragging the text to a new area. You can also use the Visual Report
Control window to display units in a legend to increase the clarity of the
display. These adjustments have already been done in Figure 2.20. This
window can be printed or copied to the clipboard for import into other
Windows graphics programs, saved to a file, or printed to an Adobe PDF
file.

Visual Report Control - Output Mode

Display Mode
O Input (@) Output Automatically Refresh Visual Report After Run

Display Parameters General Display Show Selected Pipes/Junctions Color Map

Parameter Filter

(® Output Cortrol (O All Available Parameters
Pipe Results Junction Results
[[] Mass Flow Rate (bm/sec) ~ [[] Mass Flow Rate Through Junction (bm/sec) A

Pressure Loss Stagnation Total (psid)
Pressure Stagnation Inlet {psia)
Pressure Stagnation Outlet (psia)
Pressure Static Outlet (psia)
Temperature Loss Stagnation (deg. F)
Temperature Stagnation Inlet (deg. F)
Temperature Stagnation Outlet (deg. F)
Temperature Static Inlet {deg. F)
Temperature Static Outlet (deg. F)
Enthalpy Loss Stagnation (Btu.dbm)
Enthalpy Stagnation Inlet (Btu/bm)
Enthalpy Stagnation Outlet (BtuAbm)
Enthalpy Static Inlet (BtuAbm)

||

Velocity Inlet fest/sec)
Velocity Outlet feet/sec)
Mach Mumber Inlet
Mach Mumber Outlet
Pressure Loss Stag. Total (psid)
Pressure Stagnation Inlet {psia)
Pressure Stagnation Cutlet (psia)
Pressure Static Inlet (psia)

Pressure Static Outlet (psia)
Temperature Loss Stagnation (deg. F)
Temperature Stagnation Inlet (deg. F)
Temperature Stagnation Outlet (deg. F)
Temperature Static Inlet {deg. F)
Temperature Static Outlet (deg. F)

O

Enthalpy Loss Stagnation (Btudbm) W Enthalpy Static Outlet (Btu/bm) ]
Al None || Invert Al Mone || Invert
Cutput Window Table Header: P Static In
Visual Report Abbreviation: Pin
Description Static pressure at junction inlet
The features on this tab folder are specified for the steady output mode only.
Save Options... Reset Locations
Same As Parent W Load Options... Help Cancel

Figure 2.19 The Visual Report Control window selects content for
the Visual Report window
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Figure 2.20 The Visual Report integrates results with model layout

Step 9. View the Graph Results

» Change to the Graph Results window by clicking on the Graph Results

tab or choosing it from the menu. The Graph Results window offers
full-featured Windows plot preparation.

AFT Arrow’s Graph Guide, accessed by clicking on the “What Would
You Like to Do?” button located at the top right of the Graph area,
provides assistance by guiding you through the creation of a “Quick and
Simple” graph, or an “Advanced” graph (Figure 2.21). You can create a
graph by following the prompts on the Graph Guide, by manually
specifying the graphing parameters on the Graph Control tab on the
Quick Access Panel, or from the “Select Graph Parameters” icon located
in the top left corner of the Graph Results toolbar. For the remainder of
this Quick Start Guide, the Graph Guide will be hidden, but keep in mind
that you can use it whenever you would like assistance in creating a
graph.
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Figure 2.22 shows the Graph Results window with the Graph Control tab
enabled on the Quick Access Panel.

Figure 2.21 The Graph Guide can be toggled on and off by
clicking the “What Would You Like to Do?” button on
the Graph Results window

S AFT Arow - Orifice Flow.aro (Graph Results)
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Figure 2.22 Graph Results window offers full-featured graphing

AFT Arrow gives you the ability to create “stacked graphs”. These are
graphs that are displayed on top of each other with the same X-axis but
with different parameters on the Y-axis. This feature is very helpful
when you want to look the behavior of multiple hydraulic parameters in
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the same location of your model simultaneously without having to create
completely separate graphs.

In this example, you will create stacked graphs of the pressure and
velocity along the pipeline.

» Click the Profile tab on the Quick Access Panel. In the Pipes selection
list, click the All button to select all the pipes.

» For the Length Units, select Feet.

» From the Parameters definition area, select “Pressure Static” and
specify units of psia.

> In order to add a stacked graph, click the “Add” button, which is the
green “+” icon next to “Select Parameter”. A new row under the
Parameters definition area will appear.

» Choose “Velocity” in this new parameter row, and select units of
feet/sec.

» Click the Generate button to create the stacked pressure and velocity
graphs.

» To format the legend font size, right-click on each legend and use the
scroll bar to decrease the font size to 9 for both graphs. Drag the static
pressure graph legend to the upper right corner of the graph to improve
visibility of the graphed data.

» To format each axis font size, right-click on each axis title and use the
scroll bar to decrease the size until the font size on each axis appears as
you like.

Figure 2.23 shows the input in the Parameters/Formatting area on the
Quick Access Panel.

Figure 2.24 shows the stacked graphs detailing the static pressure and
velocity along the entire pipeline modeled in this simple system. Note
that the total static pressure loss across the orifice is approximately 108
psid.
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Figure 2.23 The Graph Control tab on the Quick Access Panel
allows you to specify the graph parameters you want
to graph in the Parameters/Formatting area
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Figure 2.24 The Graph Results window offers full-featured
graphing

The graph colors, fonts and other elements can be modified using the
Formatting area on the Graph Control tab on the Quick Access Panel.
The Graph Results window can be printed, saved to file, copied to the
clipboard, or printed to an Adobe PDF file. The graph’s x-y data can be
exported to file or copied to the clipboard.

Step 10. Modify the system

So far in this example, there has been no input for “CdA for Sonic
Choking” on the Orifice Properties window. This input is optional, but
without a specified CdA, sonic choking cannot be calculated at this
location and thus, choking would not occur at the orifice. However, sonic
choking can occur at a different location, as was seen at Tank Junction

J3.
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Conclusion

To see the effects of CdA, enter a CdA that is 20% higher than the sonic
area, and run the Arrow model again. The previous sonic area at J2 was
1.38 inches?, and the new value should be 1.65 inches? (i.e., 20% higher).
How do the results change? What happens if you set the optional orifice
CdA to a value 20% lower than the sonic area (1.1 inches?)?

Note: This is a situation where a user could create two new scenarios
using the Scenario Manager to examine several "what-if" situations,
without disturbing the basic model. See Chapter 3 for an example that
illustrates how to use the Scenario Manager.

When the orifice CdA is set to a value higher than the sonic area, it has
no effect on the model. However, setting the orifice CdA to a value
lower than the sonic area will result in sonic choking at that location.

Here, a value 20% lower than the sonic area causes the flow rate to
decrease from 4.65 to 3.76 lbm/sec, and the sonic discharge pressure to
decrease to 83.4 psia. For this system, lowering the orifice CdA to a
value 20% less than the sonic area also causes the system to choke in two
places rather than just one. This can be seen on the Sonic Choking tab in
the General Output window.

You have now used AFT Arrow's five Primary Windows to build and
analyze a simple model.
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CHAPTER 3

Compressed Air System Analysis
Example

This example demonstrates how to determine the range of outlet
temperatures for a compressed air system, given a range of numerous
design assumptions.

Topics covered

This example will cover the following topics:

o Entering heat transfer data for piping

e Modeling compressors with curve data

e Modeling heat of compression at compressors

e Modeling junction losses with a resistance curve

e Using scenarios

e Using the "Copy Data From Jct..." junction editing feature
o Using the Global Pipe Edit feature

Required knowledge

This example assumes that the user has some familiarity with AFT
Arrow, such as placing junctions, connecting pipes, and entering pipe
and junction properties. Refer to the Flow Through an Orifice Example
in Chapter 2 for more information on these topics.
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Model file

This example uses the following file, which is installed in the Examples
folder as part of the AFT Arrow installation:

o Compressed Air System.aro - AFT Arrow model file

This example is provided in the model file under the English Units
scenario. It is also provided in metric units under the Metric Units
scenario.

Problem statement

In this example, four machine tools are supplied air for operations. The
machine tools are sensitive to temperature, but the manufacturer says
they can compensate for this if they know the extremes of the delivery
temperature the tools will see.

The air is taken from outside the building (P = 0 psig), and the air
temperature outside can vary from 0 to 110 deg. F. The temperature
inside the building ranges from 70 to 75 deg. F.

The compressor used to drive the system has the following stagnation
pressure rise characteristics: 12 psid at 0 Ibm/sec, 10 psid at 0.5 lbm/sec,
and 6 psid at 1 Ibm/sec. The compressor efficiency is not known with
certainty, but it is expected to be between 80% and 90%.

The nozzles at the tools have a pressure drop of 8.0 psid at 0.2 Ibm/sec.
The nozzles discharge to atmospheric pressure.

The pipes in the system are uninsulated steel, with external heat transfer
coefficients that vary from 1 to 10 Btu/hr-ft2-R. The pipe at the
compressor inlet is heavily insulated (adiabatic). All of the components
in the system are at an elevation of 0 feet.

Determine the possible temperature extremes of this system, so the
manufacturer of the machine tools can compensate for the temperature
sensitivity of the tools.

Step 1. Start AFT Arrow

From the Start Menu, choose AFT Products and AFT Arrow.
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Step 2. Specify system properties

1. Open the System Properties window by selecting System Properties
in the Analysis menu.

2. On the Fluid Data tab, select the AFT Standard database and then
select "Air" in the Fluids Available in Database list.

3. Click "Add to Model" to select air for use in this model

4. Use the default "Redlich-Kwong" for the equation of state and
"Generalized" for the enthalpy model

5. Click OK

Step 3. Build the model

A. Place the pipes and junctions

At this point, the first two items are completed on the Checklist. The next
Checklist item is to "Define Pipes and Junctions". In the Workspace
window, assemble the model as shown in Figure 3.1.
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Layout of pipe system for Compressed Air System
Example

Figure 3.1
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B. Enter the pipe data

The system is in place, but now you need to enter the input data for the
pipes and junctions. Double-click each pipe object, and enter the
following data in the Properties window:

All of the pipes are Steel - ANSI, with standard roughness and the
following data:

Pipe Length Nominal Size Type
(feet)
P1 1 2 inch Schedule 40
P2 25 2 inch Schedule 40
P3 25 2 inch Schedule 40
P4 25 2 inch Schedule 40
P5 25 2 inch Schedule 40
P6 10 1 inch Schedule 40
P7 10 1 inch Schedule 40
P8 10 1 inch Schedule 40
P9 10 1 inch Schedule 40

1. Because the pipe at the compressor inlet (P1) is very well insulated
for all of the cases you will analyze, it can be considered adiabatic.
Open the Properties window for pipe P1 and select the Heat Transfer
tab. Ensure that the Heat Transfer Model is set to "Adiabatic
(Perfectly Insulated)", then click OK.

2. For the remaining uninsulated pipes (P2 - P9), you will need to set
the pipe heat transfer properties on the Heat Transfer tab on the Pipe
Properties window.

AFT Arrow has a feature that can be used to change the heat transfer
properties for multiple pipes at the same time. This feature is called
Global Pipe Edit.
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Open the Global Pipe Edit window from the Edit menu. Click
“Select All” to select all of the pipes shown in the Pipe List. Then
click on the check box beside Pipe 1 to deselect it. Since Pipe 1 has
different properties than the other pipes (it is adiabatic), you should
not include it in this global change. The Global Pipe Edit window
should appear as shown in Figure 3.2.

Global Pipe Edit

Select Pipe Data
Al | None | Invert

Pipe List: Workspace || Special...
Pipe
Pipe
Pipe
Pipe
Pipe
Pipe
Pipe
Pipe

Click "Select Pipe Data...'to Specify Parameters

AREREEEERD
W~ T b R

| Selected: 80f 9

Figure 3.2 Global Pipe Edit window showing the pipes selected
to be included in the global edit

Click the Select Pipe Data button. This will open a Pipe Properties
window that will be used to enter the pipe parameters we wish to
change on all of the selected pipes.

On the Pipe Model tab, set the Pipe Material to Steel - ANSI. No
other changes are necessary on this tab.

Click on the Heat Transfer tab. Select "Convective Heat Transfer"
for the Heat Transfer Model, and enter 75 deg. F for the Ambient
Temperature. Change the External Convection Data Source from
Correlation to User Specified. Enter 1 Btu/hr-ft2-R for the External
Convection Coefficient. Also, ensure that the Gnielinski correlation
is selected under the Convection Coefficient column in the Fluid
Internal row. The Pipe Properties window should appear as shown in
Figure 3.3. Select OK.
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Pipe Properties
OK
Name: Pipe ~ Cancel
Copy Data From Pipe... w
Help
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Extemal User Specified - [ | 1 1

Figure 3.3  The Heat Transfer tab is where you specify heat
transfer properties for the pipe

The Global Pipe Edit window will now display a list of all the
parameters that may be applied to the selected pipes. The parameters
are categorized as they are displayed on the tabs on the Pipe
Properties window. For this example, you want to select all of the
parameters listed in the Heat Transfer category (see Figure 3.4).
Since these items are the only things selected in the parameter list,
they are the only parameters that will be changed in the pipes.

Select the Apply Selections button, acknowledge the "changes
complete" message, and then select the OK button to close the
Global Pipe Edit window.

The heat transfer data for Pipes P2 - P9 have all been updated to
reflect the new values. Open the Properties window for one of the
pipes to verify that the changes were made.
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Replace All ~ Insulation #2 Replace Existing Insulation ;
Replace All ~ Insulation #3 Replace Existing Insulation §
Replace All o External Replace Existing External D
=[] Design Merts
[ Replace With |~ Design Alerts (none)
=[] Optional
[ Replace With |~ | Show on \Workspace MNumber
O Specizl Condition Naone
[] Replace With |~ | Initial Flow Unspecified
O Diesign Factor 1 W
£ >
| Selected: 8cf 9 = @|r
Cancel Help

Figure 3.4  Global Pipe Edit window showing the parameters to
be applied to all pipes selected in the Pipe List

C. Enter the junction data

J1 Atmosphere
1. Elevation = 0 feet

2. Pressure = 0 psig
3. Temperature =110 F

J2 Compressor
1. Elevation =0 feet

2. Select Centrifugal Compressor and set the Compressor Model to
Compressor Curve

98]

Choose the “Added Pressure” as Stagnation

b

Set the “Compression Process Thermodynamics” to “Determine
From Efficiency Data”
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5.

Select the Enter Curve Data button. Enter the Compressor Curve
pressure and efficiency data from the following table into the Raw
Data table in the Compressor Configuration window that is shown in
Figure 3.5

m' dp Efficiency
(Ibm/sec) (psid) (percent)
0 12 80
0.5 10 80
1 6 80

After the curve data is entered in the Raw Data table, select the
Pressure Rise and Efficiency check boxes in the curve fitting section
of the Compressor Configuration window (see Figure 3.5). This will
cause curve fits for both pressure and efficiency to be calculated.
Then, select the Generate Curve Fit Now button to generate the
Compressor Performance graph (see Figure 3.6). Select the OK
button on the Compressor Configuration window to accept the
Compressor curve fit and to close the window. Select the OK button
to close the Compressor/Fan Properties window.

J7 (Tool #1)

L.

2
3
4
5.
6
7
8

Enter the Name as Tool #1

Elevation = 0 feet

Set the “Valve Data Source” to “User Specified”

Set the “Subsonic Loss Model” to “Resistance Curve”
Check the optional Exit Valve Box

Exit Pressure = 0 psig

Exit Temperature = 70 deg. F

Select the Enter Curve Data button. Select the Flow Parameter as
Mass flow in Ibm/sec. Enter 0.2 Ibm/sec and 8 psid in the proper
columns in the Raw Data table, then select the Fill As Quadratic
button to generate the Valve loss curve data. Then select the
Generate Curve Fit Now button to generate the valve loss curve.
Select the OK button to accept the curve fit and to close the Valve



Chapter 3 Compressed Air System Analysis Example 51

Loss Curve Fit window. Select the OK button to close the Valve
Properties window.

Compressor Configuration
Configuration Method
@ Smple O Mutiple
j Compressor Data | Configuration Data Composite Graph  Performance Graph Efficiency Graph
Curve Fitting
Raw Data optonaibaa | Curve o Tpe:
4 Flow Head/Pressure | Efficiency/Power Interpolated X-Y Data
m' dP .
Parameter Mass |v | Pressure |\ | Efficiency
Units |Ibmisec |+ | psid |\ | Percent
1 0 12 (e
2 5 )
3 1 s e
4 ]
5 I
6 ]
7 I
8 I
9 ] COMPRESSOR CURVE
10 I %
n I
12 ]
13 I EFFICIENCY
14 [ v
AL |AP=a+b:ri'l+cn'o2 +dm3 +em?
Reference Density E]
® Mo Corecton
O Unr et
| OK || Camcel || Hep |

Figure 3.5

The Compressor Configuration window is where
performance data is entered and fitted with a curve

J8, J9, J10 (Tool #2, Tool #3, and Tool #4)
1.

For J8, open the Valve Properties window, and select J7 (Tool #1)
from the “Copy Data From Jct...” list. This will open the Copy Data
From Junction window. Click the “All” button. This will cause all of
the properties for J§ to be set the same as the properties for J7. Since
you want the J§ tool to retain its unique name, click on the check box
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next to the Name parameter to deselect it (see Figure 3.7). Select the
OK button. J8 now has all of the same properties as J7, with the
exception of its name.

2. Enter the name as Tool #2

3. Repeat this process for J9 and J10, entering names of Tool #3 and

#4, respectively.
Compressor Configuration
Configuration Method
@ Simple O Multiple
Compressor Data Configuration Data Compaesite Graph Performance Graph Efficiency Graph
Compressor Performance
12 81
17 - 50.8
10 o i
- - 60.6
9 - -
=3 3 ] -804 m
2 " i 3
— 802 5
5 L ° 3
X g = =
@ 2] B &0 = m— Pressure Rise
§ 5 ] L 79 5 g = Efficiency
S 4 [ E
o b - 796 =
7 [ 794
2 1 e
1] 792
0 — T m
0 0.2 04 0.6 0.8 1 1.2 14 16
Mass Flow Rate (Ilbm/sec)
Max X-Axis Value: |1.5 | | Update Graph | Print Graph Customize Graph...
0K Cancel Help

Figure 3.6  Compressor Configuration window Composite Graph
tab showing plots of curve fits generated from the
Raw Data table

J3, J4, J5, and J6 Branch Junctions

1. Open the Branch Properties window and enter an elevation of 0 feet
for all of the Branch junctions.
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D. Check if the pipe and junction data is complete

Turn on “Show Object Status” from the View menu to verify that all the
necessary data is entered. If all data is entered, the “Define Pipes and
Junctions” Checklist item on the Quick Access Panel will have a check
mark. If not, the uncompleted pipes or junctions will have their number
shown in red on the Workspace. If this happens, go back to the
uncompleted pipes or junctions and enter the missing data. You can also
open the Undefined Objects list from the View menu by clicking on “List
Undefined Objects...” to see what data is missing.

Copy Data From Junction 7 (Tool #1)

Parameters to Change (Select in List): Al None || Invert
—/[m] General Data A Cancel
O Name Tool #1
Elevation 0 feet
= Loss Model

Valve Data Source User Specified (Mot Handboolk)

Variable Loss Type  Pressure (psid) vs. Mass Flow Rate (Ibm/sec)
Constants 3.996803E-15,-5.684342E-14.200

Reference Density Mo Correction

Exit Pressure/HGL 0 psig

KEREERREE

Exit Temperature 70 deg. F
Basze Area Upstream Fipe Area
CdA Unspecified
- [~| Dptional
Replace With |~ | Show on \Workspace MNumber, Name
Design Factor 1

Replaoe\"ﬁth ~ | Initial Pressure/HGL Unspecified
] Replace With |« | Initiasl Temperature  Unspecified

Junction lcon Apply Selected Junction lcon

Junction Size Default

Special Condition Neone

= A Pa L AW T_LI_ v
< >
=i {1

Figure 3.7 The Copy Data From Junction window for junction J8
allows you to copy selected data from one junction to
another

Step 4. Create scenarios for the extreme temperature cases

For this problem, you are required to determine the temperature extremes
at the tools based on the range of system specifications. To do this, you
will use the Scenario Manager to examine the hot and cold extremes for
the system.
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The Scenario Manager is a powerful tool for managing variations of a
model, referred to as scenarios. The Scenario Manager allows you to:

e C(Create, name and organize scenarios

e Select the scenario to appear in the Workspace (the ‘current’
scenario)

e Delete, copy and rename scenarios

e Duplicate scenarios and save them as separate models
e Review the source of a scenario’s specifications

e Pass changes from a scenario to its variants

You will create two scenarios to model these cases. Scenarios are created
using the Scenario Manager from the Tools menu or the Scenario
Manager on the Quick Access Panel. The Quick Access Panel, located
on the right side of the Workspace area, contains the Scenario Manager
on the Scenario tab. A scenario tree displays all model scenarios.

Click the "Create Child" icon on the Scenario Manager on the Quick
Access Panel (see Figure 3.8). Name the child “Hot Case”. A new
scenario will appear below the Base Scenario in the scenario tree. Select
the Base Scenario, create another child, and call it “Cool Case” (see
Figure 3.8). Note that the new child scenario is loaded when it is created
using the Quick Access Panel.

Step 5. Set up Hot Case scenario

Child scenarios “inherit” data from their ancestors. As long as the data
has not been modified in a child scenario, data parameters in the child
scenario will have the same value as their parent. Since the Base
Scenario already contains all of the basic information for the model, such
as the pipe and junction layout, pipe lengths, etc., you only need to
modify the system conditions to simulate the case that will result in the
hottest temperature at the tools.

Double-click the “Hot Case” scenario in the scenario tree of the Scenario
Manager on the Quick Access Panel. This will load the “Hot Case”
scenario onto the Workspace as the current scenario. The currently
loaded scenario is displayed in the scenario tree with a green check mark
(Figure 3.8). Alternatively, you can use the Scenario Manager window
from the Tools menu to load the scenario.
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Scenario Manager r

ol B ST BT =
-l & Base Scenario

----- o Hot Casze
----- & Cool Case

Notes

=a Scenario | |EE| Propertes

e L=NL)

Figure 3.8  The Scenario Manager on the Quick Access Panel
displays the scenario tree that allows you to create
model variants (scenarios) and keep them organized
within the same model file

In order to simulate the highest temperature case at the tools, you need to
decide which design requirements will result in the highest tool
temperatures. This will occur for the highest inlet and ambient
temperatures for the air, and the heat transfer properties of the piping
which will result in the least amount of heat loss.

Modify the following model information as indicated:

J1 Atmosphere (Tank)
1. Set the temperature to the highest value of 110 deg. F.

J2 Compressor

1. The compressor will generate more heat if it is less efficient. Since
this is the high temperature case, you should assume the worst
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possible efficiency, which is 80%. This data is entered on the
Compressor/Fan Configuration window. Since you used 80% in the
table when you added the Compressor information in the Base
Scenario (Step 3), the compressor in this scenario has already
inherited the Compressor curve for 80% efficiency, so no change is
necessary.

Pipes P2 - P9

1.

The heat transfer properties of the uninsulated pipes (P2 - P9),
should be set to the values which will minimize the heat transfer
occurring in the pipe, and result in the highest temperature at the
tools.

For this case, you should use the highest ambient temperature of 75
deg. F and set the external convection coefficient to 1.0 Btu/hr-ft2-R
which will yield the lowest heat loss. Since you used this same data
when you added the pipe heat transfer data in the Base Scenario
using the Global Pipe Edit feature (Step 3), the pipes in this scenario
have already inherited this heat transfer data, so no change in the
heat transfer data is necessary. To verify this, click on Pipe P2 to
open the Pipe Properties window. Select the Heat Transfer tab. The
data should appear the same as shown in Figure 3.3.

Step 6. Run the Hot Case scenario

Select “Run Model” in the Analysis menu. This will launch the Solution
Progress window. This window allows you to watch as the AFT Arrow
Solver converges on the answer. When the solution has converged, view
the results by pressing Output at the bottom of the Solution Progress
window.

The Output window contains all the data that was specified in the Output
Control window. The output for the Hot Case Scenario is shown in
Figure 3.9. The junction output table shows the highest inlet static
temperature at the tools for the Hot Case is 202.3 deg. F.
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,-"' Workspace ﬁ Model Data Eoutput | [ Graph Results & Visual Report

D g |2 |35 3

General Warnings

| valve Summary

Name Mass Wal. dP dP dH Owerall Speed | Owerall| Comp. EEP BEP % of
Jot | Fesults Flow Flow | Stag. | Static = Static | Efficiency Power | Ratio Q Mass BEP
Diagram (Ilbm/sec) | (ft3/sec) | (psid) | (psid) | (feet) | (Percent) | (Percent) | (hp) | (Percent) | (ft3/sec) | (Ibmisec) | (Percent)
2 | Show D Compressor 0.5651 8600 9532 9884 17993 20.00 1000 2115 165.8 NIA MIA NIA
Fipes | Axial Points  Heat Transfer
MName | Mass Vel. In Vel. Mach Mach | dP Stag. | PStag. | P Stag. | P Static | PStatic | dT Stag. | TStag. | TStag. | »
Pipe Flow Rate Out #in #Out Total In Out In Out Inlet Outlet
(lbmizec)  (festisec)  (fest/sec) (psid) (psia) | (psia) | (psia) (psia) (deg. F) | (deg. F) | (deg. F)
1 |Pipe 0.5651 36571 369.04 031573 031866 01193 1470 1458 137 1358 0002318 110.0 1100
2 |Pipe 0.5651 257.80 28184 020252 022274 2150 2417 2205 2345 21N

4444647 2188 2154

<

>

All Junctions | Branch CompressorfFan Tank Valve

dP Stag. | P Stag. | P Stag. | P Static | P Static |  dT TStag. | TStag. | T Static | T Static dH
Jet| Total In

HStag. | HStag. | HStatic | Ha
Out In Out Stag. Inlet | Outlet In Out
(psid) | (psiz) | (psiz) | (psia) | (psia) | (deg.F) | (deg. F) | (deg. F) (deg F) | (deg. F)

Stag. In Cut In
(Btwibm) | (Btwlbm) | (Btwlbm) | (Btwlbm) | (B

4 0000 2087 2087 2051 2051 00 2096 2096 20626 2063 NAA 287 2287 2278
5 0000 2034 2034 2012 2012 00 2012 212 19920 1992 NAA 2267 2267 2262
6 0000 2020 2020 2016 1954 0.0 186.4 186.4

P

26 04 1804 0.00 2231 2231 2230
4822 18352 1470 18.54 1470 0.0 2119 211.9 2023 0.00 2233 2233 2263 v
£
Figure 3.9 Output window for Hot Case Scenario

When compressors/fans are included in a model, AFT Arrow gathers the
related data together in one convenient location in the Output window.
This information can be found on the Compressor/Fan Summary tab

located in the General Output section of the Output window, as shown in
Figure 3.10.

General Warnings

Walve Summary

Name Mass Vol. dP dP dH Owverall Speed | Overall | Comp. BEP EEP % of
Jot | Desults Flow Flow | Stag. Static Static | Efficiency Power | Ratio [¢] Mass BEP
Diagram (Ibmisec) | (ft¥sec) | (psid) | (psid) | (feet) | (Percent) | (Percent) | (hp) | (Percent)  (ft3sec) | (Ibmisec) | (Percent)

2 | Show D Compressor 0.5651 2600 9592 9.8 17,993 20.00 100.0

2115 165.8 /A /A NIA

Figure 3.10 The Output window displays the Compressor/Fan
Summary tab whenever a compressor/fan is modeled

From Figure 3.10, the Compressor/Fan Summary shows that, for this
system, the head requirement of the compressor is 18.0 feet, and the
mass flow is 0.57 Ibm/sec.
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The Compressor/Fan Summary can also be displayed in a Results
Diagram, as shown in Figure 3.11, by selecting the button next to
“Show” in the Results Diagram column, double-clicking anywhere in the
row, or right-clicking anywhere in the row and selecting Results
Diagram.

Compressor Results Diagram

Y

EE) =] X

Copy Diagram Print Diagram Close

Compressor J2 (Compressor) Results

P =23.49 psia
Po=24.17 psia

P =13.59 psia
Po = 14.58 psia

Volume Flow = 8.600 ft3/sec
Mass Flow = 0.5651 Ibm/sec
dH = 17,993 feet
dP = 9.884 psid
Overall Power=21.15hp
Speed = 100.0 Percent
Overall Efficiency = 80.00 Percent
BEP = N/A
Percent BEP = NJA

Figure 3.11 Compressor Results Diagram

The pipe heat transfer results from the Heat Transfer tab (see Figure
3.12) can also be displayed in a Results Diagram, as shown in Figure
3.13, by selecting the button next to “Show” in the Results Diagram
column, double-clicking anywhere in the row, or right-clicking anywhere
in the row and selecting Results Diagram.
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Pipes Axial Points | Heat Transfer

Name | TFluid | TFlsid | Tinlet | T Outlet T Inlet T Outlet T
Pipe &?;alﬁ Inlet | Outlet | Wiall Inside | Wall Inside | Wall Outside | Wall Outside | Ambient
(deg. F) | (deg. F) | (deg.F) (deg. F) (deg. F) (deg.F) | (deg.F)

2 |show [ Pipe 21439 20887 2172 2128 2171 2128 7500
3 |show [ Pipe 21206 20587 2119 2062 2119 2062 7500
4 |show[JrFipe 20802 13962 2047 1966 2046 1966 7500
5 |Show[] Pipe 20084 18604 1929 1790 1928 1790 7500
6 |Show [ Pipe 20791 20225 2132 2097 2131 2097 7500
7 |show [l Fipe 20278 15740 2072 2036 2072 2006 7500

Figure 3.12 The Heat Transfer tab in the Output window shows
detailed heat transfer results for pipes

Pipe Heat Transfer Results Diagram

= L€ x
Copy Diagram Print Diagram Close
Pipe P6 Resulis
P =21.20psia Volume Flow Average = 1.932 ft3] P = 18.54 psia
Po=22.05 psia e Po=19.52psia

Tamb=75.00deg. F

Temperature Diskribution (deg. F)

21314 OuterWall  209.69
21320 InnerWall  209.75
20797 BulkFluid  202.25

Figure 3.13 Pipe Heat Transfer Results Diagram
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Step 7. Graph the Results

AFT Arrow allows you to create dual Y-axis graphs, which plot two
parameters on the same graph.

In this example, you will graph the static temperature and the static
pressure from the J1 tank through the pipeline to Tool #4 (J10) on a dual
Y-axis graph to help you understand how the temperature and pressure
change as the air flows through the pipeline.

Note: You can repeat this process for the flow path from the J1 tank to
the other tools, or you can graph the flow through each path on this same
graph using the Plot Multiple Paths Using Graphs feature.

1. From the Graph Control tab, choose the Profile tab in the
Parameters/Formatting area, specify “Plot Single Path” in the Pipes
definition area, then select pipes 1, 2, 3, 4, 5, and 9. These pipes
make up the path from the J1 tank junction to Tool #4.

2. Ensure that feet is selected for the Length Units.

You will need to decide what parameter you wish to plot on the primary
Y-axis and which parameter you want to plot on the secondary Y-axis. In
this example, we will plot static pressure on the primary Y-axis and static
temperature on the secondary Y-axis.

3. To do this, select “Pressure Static” in the Parameters definition area
and choose “psia” as the static pressure unit.

4. Add a parameter by clicking on the “Add” button next to “Select
Parameter” in the Parameters definition area.

5. Change this added parameter to “Temperature Static” and choose
deg. F as the unit.

6. To specify that the temperature will be plotted on the secondary Y-
axis, first select this parameter by clicking on the box to the left of
“Temperature Static”, then click on the “Make Secondary Y-Axis”
icon (this is the blue, right arrow icon located at the top right over the
selected parameters). Alternatively, you can double-click on the box
to the left of “Temperature Static” in the Parameters definition area.
Note that “Temperature Static” becomes indented under “Pressure
Static”, and that the black arrow next to “Temperature Static” turns
to point towards the graph. See Figure 3.14 to see how these
graphing parameters are defined.
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7 Parameters

ﬂ CompressorfFan vs. System Curve

=+% Formatting =

Pipes: Plot Single Path
Al 1 Pipe

P Pipe

Mone 3 Pipe

Invert 4 Pipe

Workspace e Fipe

Spedal... 17 Pipe

I Pine

Length Units: | feet
Select Parameter

Parameter
w| | Pressure Static

4 v| Temperature Static

« Generate

sam Scenario | | Graph Control

g Add -~ X Remove
Units

¥ | psia

| deg.F

-

Figure 3.14 Parameter definition for dual Y-axes graph of static
pressure (Primary Y-axis) and static temperature
(Secondary Y-axis) on the Graph Control tab on the

Quick Access Panel

Click the Generate button. You will see that the static pressure and
temperature increase after the air flows through the compressor, and then
these parameters gradually drop as the air flows through the pipes and to
each tool. See Figure 3.15 for this graph.
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Graph Results o x

3| By s BE 3 [+ [ | e E | € 100% 23 Format = | o £% WhatWould You Like to Do?

Pressure Static vs. Flow Length

30 — 300
25 — 250 g
— 1
o —— 0]
B T~ | &
o >~ 1 c
S o
8 15 150 ¢n
ph &
g T =3
= Oy
B w0 — 100 —
: 3
= IR
5 . - 30
Pressure Static I
Temperature Static |
0 0
0 20 40 60 80 100 120
Flow Length (feet)
B x g 7 -

Figure 3.15 Pressure and temperature from the J1 tank junction to
Tool #4 plotted on a dual Y-axis graph

Step 8. Set up Cool Case scenario

Double-click the “Cool Case” scenario in the list in the Scenario
Manager on the Quick Access Panel. This will load the “Cool Case”
scenario onto the Workspace as the current scenario.

In order to simulate the coolest temperature case, you must assume the
lowest inlet and ambient temperatures, and the heat transfer properties
for the piping that result in the largest amount of heat transfer.

Modify the following model information as indicated:

J1 Atmosphere (Tank)
1. Set the temperature to lowest value of 0 deg. F.
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J2 Compressor

7. The compressor will generate less heat if it is more efficient. Since
this is the lower temperature case, you must assume the best possible
efficiency, which is 90%. This data is entered on the
Compressor/Fan Configuration window. When you added the
compressor information in the Base Scenario (Step 4), the efficiency
was entered in the table as 80%. Change the efficiency in the table to
90%. Select Efficiency under Curve Fitting, and then click the
Generate Curve Fit Now button to generate a new efficiency curve.
Close the Compressor Configuration and Properties windows by
selecting the OK button.

Pipes P2 - P9

1. Set the heat transfer properties of the uninsulated pipes downstream
of the compressor (P2 - P9) to the values that will result in the lowest
gas temperatures at the tools. The appropriate ambient temperature to
use is the lowest of 70 deg. F. However, it is not clear which
convection coefficient should be used. If the heat of compression at
the compressor heats the gas to a temperature higher than 70 deg. F,
we should use the highest external convection coefficient value of 10
Btu/hr-ft2-R. This will permit maximum cooling of the gas in the
pipe. On the other hand, if the compressor discharge temperature is
less than 70 deg. F, then the lowest external convection coefficient
value of 1 Btu/hr-ft2-R should be used. This will yield the least
heating of the gas in the pipes, giving the lowest possible
temperature at the tools. Here we will use the value of 10 Btu/hr-ft2-
R. As just discussed, in practice one would need to verify the validity
of this assumption.

2. Use the Global Pipe Edit feature to change the heat transfer
properties in Pipes P2 - P9. Set the Ambient Temperature to 70 deg.
F, and set the External Convection Coefficient to 10 Btu/hr-ft2-R.
Also, ensure that the Gnielinski correlation is selected under the
Convection Coefficient column in the Fluid Internal row.

Step 9. Run the Cool Case scenario

Select “Run Model” in the Analysis menu. When the solution has
converged, view the results by clicking on the Output button at the
bottom of the Solution Progress window.
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The output for the cool Case Scenario is shown in Figure 3.16. The

junction output table shows the lowest inlet static temperature at the tools

for the cool Case is 65.6 deg. F. Note that the compressor discharge
stagnation temperature is 77.9 deg. F (not shown in Figure 3.16), and

thus the assumption of 10 Btu/hr-ft2-R for the convection coefficient was

appropriate.

i Workspace ﬁ Meodel Data [ Output | [ Graph Results &> Visual Report

D eE 2| 2 |Ba |5 S

General Warnings

Valve Summary

Mame Mass Val. dP dP dH Overall Speed | Overall | Comp. EEP EEP % of
Jot| esults Flow Flow | Stag. | Static | Static | Efficiency 'ower | Ratio Mass BEP
Diagram (Ibmisec) | (ft3/sec) | (psid) | (psid) | (feet) (Peroent) (Percent) | (hp) | (Percent) | (ft3/sec) | (Ibm/sec)  (Percent)
2 | Show [] Compressor 05880 7290 9373 9633 13,982 80.00 100.0 1570 164.2 N/A N/A

Fipes  Axial Points  Heat Transfer

Figure 3.16 Output window for Cool Case Scenario

Analysis summary

Name | Mass Vel. In Vel. Mach Mach | dP Stag. | P Stag. | P Stag. | P Static | P Static | dT Stag. | T Stag. Inlet | T Stag.
Pipe Flow Rate Out #in #0ut Total In Out In Out Outlet
(Ilbm/sec) | (feetisec) | (feet/sec) (psid) | (psia) | (psia) | (psia) | (psia) | (deg. F) (deg. F) (deg. F)
1 |PFipe 0.5380 31038 312.84 029771 0.30011 0.1054 1470 14539 1382 1370 0004120 000001343 -0.004106
2 | Pipe 0.5380 217.04 23520 0.19169 0.20821 18523 23% 2211 2336 2145 1.828796 7794334412 76.114548
3 |Pipe 0.4356 169.57 177.56 014373 015714 10400 2211 2107 2177 2071 1750610 76.12089539 74.370285
4 |Pipe 0.2859 11573 118.02 010228 010446 04678 2107 2060 2052 2044 1625316 7437474060 72748825
< >
All Junctions | Branch  CompressorfFan Tank Valve
dP Stag. | P Stag. | P Stag. | P Static | P Static T T Stag. Inlet T Stag. T Static In | T Static Out dH HStag. | H Stag.
Jet| Total In Out In Out Stag. Outlet Stag. In Out
(psid) | (psia) | [psia) | (psiz) | (psia) | (deg.F) | (deg.F) (deg. F) (deg. F) (deg. F) | (Btwlbm) | (Btwlbm) | (Btwlbm)
6 0.000 2048 2048 2044 19588 0.00 71.29759216 71.29759216 71.01097107 66.80046082 0.00 1954 1354
7 5281 1938 1470 1916 1470 0.00 7489335632 74.89335632 6852323914 6852323914 0.00 1963 1963
8 4487 1918 1470 1846 1470 0.00 7342997742 73.42937742 6762510681 67.62510681 0.00 1959 1959
9 4138 1883 1470 1816 1470 0.00 7212260437 72.12260437 A25291  66.61485251 0.00 1356 1356
10 4043 1875 1470 1809 1470 0.00 70.57138925 70.97135325 65.56297302 0.00 1853 1853
< >

By carefully selecting the input parameters from the specified system

parameters, you were able to use AFT Arrow to determine the

temperature extremes of the gas being supplied to the tools in a
compressed air system. The temperature extremes of 65.6 deg. F to

202.25 deg. F can now be sent to the tool manufacturer, who will use it

to compensate for the temperature sensitivity of the tools.



Chapter 3 Compressed Air System Analysis Example 65

Isometric Pipe Drawing Mode

AFT Arrow allows the user to place pipe or junction objects anywhere in
the Workspace.

Objects are placed on a 2D grid by default, as was the case with this
example. Figure 3.17 shows the compressed air system with the 2D grid
displayed (select Show Grid from the Arrange menu).

‘Workspace o x

D b | I R LY WAL e R L= R ORI IR R= X
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TH r-1 J7 J8 J9 J10
Tool #1 Tool#2 Tool #3 Tool #4
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Base Scenario |:;-'_‘I|';2,'IDST;|I§I L] l-!_-n-b-E | B 10

Figure 3.17 Compressed air system with 2D grid shown

At times it may be convenient to demonstrate the three-dimensional
nature of a system. For example, if you are building a model based on
isometric reference drawings. AFT Arrow includes an Isometric Pipe
Drawing Mode for these cases. The isometric grid has three gridlines that
are offset by 60°, representing the X, y, and z axes. Figure 3.18 shows the
compressed air system built on an isometric grid.
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Figure 3.18 Compressed air system with isometric grid shown

You can enable the isometric grid by going to the Arrange menu. Under
Pipe Drawing Mode, there are three options: 2D Freeform (default), 2D
Orthogonal, and Isometric.

Creating the compressed air system on an isometric grid will demonstrate
how to use this feature.

1. Go to the File menu and select New.

2. From the Arrange menu, Show Grid and choose Isometric under Pipe
Drawing Mode.

3. Place junctions J1-J7 on the Workspace in the positions shown in
Figure 3.18.

4. You will notice that placing junctions onto the Workspace follows
the usual rules, however, the visual appearance of the icons can be
more complex than on a 2D grid. Due to the increased number of
axes, the preferred icon and rotation can be selected to obtain visual
consistency. Right click on J7 and select Customize Icon. Select the
icon shown in Figure 3.19.



Chapter 3 Compressed Air System Analysis Example 67

Workspao=
) Hints |

< <> >

==
o0
> @
==
P ™
=71
-
EE =
D A
= D)
5 s

Base Scenario

=

|

P1

Customize lcon

b | oA | 4

AFT Arrow Default | User Default

Current Toolbox

pd

More...

Cancel

Figure 3.19 Right click on the junction to open the Customize Icon
window and select the preferred icon and rotation

5. Copy J7 for the tools, J8-J10, to maintain the preferred icon.

6. Draw P1, as shown in Figure 3.20.

7. Draw P2 from J2 to J3. A red-dashed preview line will show how the
pipe will be drawn on the isometric grid. As you are drawing a pipe,
you can change the preview line by clicking any arrow key on your
keyboard or scrolling the scroll wheel on your mouse. Figure 3.20
shows Pipe 2 being drawn with the preview line.
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Figure 3.20 A preview line shows when drawing or adjusting
pipes
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Base Scenario

Note: You can hold the “Alt” key while adjusting a pipe by the endpoint
to add an additional segment. This can be used with the arrow key or
mouse scroll wheel to change between different preview line options.

8. Draw pipes P3-9, as shown in Figure 3.21.
9. The grid can be shown or turned off in the Arrange menu.
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Figure 3.21 Compressed air system with isometric grid not shown



CHAPTER 4

Natural Gas Burner System Example

This example demonstrates how to size a heat exchanger to deliver
natural gas at a minimum required temperature.

Topics covered

This example will cover the following topics:

e Sizing a heat exchanger for a particular system
e Entering a loss curve for a heat exchanger

e Specifying heat transfer data for pipes

e Use of flow control valves

Required knowledge

This example assumes that the user has some familiarity with AFT
Arrow such as placing junctions, connecting pipes, and entering pipe and
junction properties. Refer to the Flow Through an Orifice Example in
Chapter 2 for more information on these topics.

Model file

This example uses the following file, which is installed in the Examples
folder as part of the AFT Arrow installation:

e  Natural Gas Burner.aro - AFT Arrow model file
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This example is provided in the model file under the English Units
scenario. It is also provided in metric units under the Metric Units
scenario.

Problem statement

An underground storage reservoir containing natural gas made up mostly
of methane supplies gas to five burners. The gas source is at 500 psig,
and 50 deg. F. The gas is supplied to each of the burners at 100 psig. To
assure that the flow to each of the burners is equal, each burner has a
control valve that controls the flow to 5 Ibm/sec.

The pipes in the system are uninsulated STD (schedule 40) steel pipes,
with standard roughness. The ambient temperature surrounding the pipes
is 75 deg. F, and the pipes have an external heat transfer coefficient of 10
Btu/hr-ft2-R.

In order to operate at the best efficiency, the gas should be delivered to
the burners at a minimum stagnation temperature of 100 deg. F. To
achieve this, the gas flows through a heat exchanger which has a 10 psid
pressure drop at 25 lbm/sec.

How much heat must be added by the heat exchanger to ensure that all of
the burners will receive gas at the specified minimum temperature?
Elevation changes can be neglected.

Step 1. Start AFT Arrow

From the Start Menu choose AFT Products and AFT Arrow.

Step 2. Specify system properties
1. Open the System Properties window by selecting System Properties
in the Analysis menu.

2. On the Fluid Data tab, select the AFT Standard database and then
select "Methane" in the Fluids Available in Database list.

3. Click "Add to Model" to select methane for use in this model.

4. Use the default "Redlich-Kwong" for the equation of state and
"Generalized" for the enthalpy model. Click OK.
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Step 3. Build the model

A. Place the pipes and junctions
At this point, the first two items are completed on the Checklist. The next

Checklist item is to "Define Pipes and Junctions". In the Workspace

window, assemble the model as shown in Figure 4.1.
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Layout of pipe system for Natural Gas Burner System
Example

Figure 4.1

B. Enter the pipe data

The system is in place, but now you need to enter the input data for the
pipes and junctions. Double-click each pipe and enter the following data
in the Properties window (or use the Global Pipe Editing window, as
discussed in Chapter 3).

All of the pipes are Steel — ANSI, STD (schedule 40), with the Standard
friction model and the following data:
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Pipe Length Nominal
(feet) Size
P1 100 4 inch
P2 20 4 inch
P3 20 4 inch
P4 20 4 inch
P5 20 4 inch
P6 4 3 inch
P7 4 3 inch
P8 4 3 inch
P9 4 3 inch
P10 4 3 inch
P11 4 3 inch
P12 4 3 inch
P13 4 3 inch
P14 4 3 inch
P15 4 3 inch
P16 20 4 inch

Enter the following data on the Heat Transfer tab for each pipe, as shown
for P1 in Figure 4.2:

1. Heat Transfer Model = Convective Heat Transfer
2. Ambient Temperature = 75 deg. F

3. External Convection Data Source = User Specified
4

External Convection Coefficient = 10 Btu/hr-ft2-R
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Figure 4.2 Pipe 1 Heat Transfer window

C. Enter the junction data

J7, J9, J11, J13, J15 flow control valves

1. Elevation = 0 feet

2. Valve Type is Flow Control (FCV)
3. Control Setpoint, Mass Flow Rate = 5 lbm/sec

J1 Supply Reservoir (modeled as a Tank junction)

1. Elevation = 0 feet

2. Pressure = 500 psig

3. Temperature = 50 deg. F

J8, J10, J12, J14, J16 burners (modeled as Tank junctions)

1. Elevation = 0 feet

2. Pressure = 100 psig

3. Temperature = 500 deg. F
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J2, J3, J4, J5, J6 branch junctions
1. Elevation = 0 feet

J17 Heat Exchanger
1. Elevation =0 feet

2. Enter Loss Model Data

a. Select the Loss Model as "Resistance Curve", and then click the
"Enter Curve Data" button

b. Select the “Flow Parameter” as “Mass”
Enter 25 Ibm/sec and 10 psid in the Raw Data table

d. Click the "Fill as Quadratic" button to create data for a square
loss curve

e. Select "Generate Curve Fit Now" to create a quadratic curve fit

To solve this problem, you will have to guess how much heat to add to
the heat exchanger, examine the results, and adjust the heat added until
you achieve the desired minimum temperature at the burners. To do this,
select the Thermal Data tab on the Heat Exchanger Properties window,
and select the Thermal Model as "Specified Heat Rate In Constant".
Then enter a value for Heat Flow Into System. For the first guess, use
500 Btu/s.

D. Check if the pipe and junction data is complete

Turn on “Show Object Status” from the View menu to verify that all the
necessary data is entered. If all data is entered, the “Define Pipes and
Junctions” Checklist item on the Quick Access Panel will have a check
mark after the Checklist is opened. If not, the uncompleted pipes or
junctions will have their number shown in red. If this happens, go back
to the uncompleted pipes or junctions and enter the missing data. You
can also open the Undefined Objects list from the View menu by clicking
on “List Undefined Objects...” to see what data is missing.

Step 4. Run the model

Select “Run Model” in the Analysis menu. This will open the Solution
Progress window. This window allows you to watch as the AFT Arrow
Solver converges on the answer. Once the model has converged, you can
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view the results by clicking on the Output button at the bottom of the
Solution Progress window.

Step 5. Examine the results

The Output window contains all the data that was specified in the Output
Control window.

Examination of the stagnation temperature at the outlets of the pipes
discharging to the burners shows that the lowest temperature is

64.2 deg. F (see Pipe 15 in Figure 4.3). This is well below the required
minimum temperature of 100 deg. F. The heat added to the heat
exchanger must be increased, and the model must be run again to
determine the outlet temperature at the new value.

Step 6. Iterate on heat rate

By trial and error, you will find that you need to add 1005 Btu/sec to the
heat exchanger to achieve a minimum stagnation temperature of 100 deg.
F.

Analysis summary

Using AFT Arrow, you were able to determine the amount of heat
required by the heat exchanger to supply natural gas to the burners at the
minimum required temperature.

The goal seeking capabilities in the optional AFT Arrow GSC Module
would allow this problem to be solved directly without manual iteration.
The variable would be specified as the heat exchanger heat rate, and the
goal would be the minimum discharge pipe exit temperature.

More discussion on the GSC Module is given in Chapter 5.
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Figure 4.3  Output for Natural Gas Burner System Example




CHAPTER 5

AFT Arrow Add-on GSC Module Example

This example demonstrates how to use the Goal Seek and Control (GSC)
optional add-on module to AFT Arrow. The user can only perform these
examples if access to the relevant module is available.

Topics covered

This example will cover the following topics:
e Goal Seek and Control Manager

e Defining GSC Variables and Goals

e Using Group Max/Min Goals

e Linking Variables

Required knowledge

This example assumes that the user has some familiarity with AFT
Arrow such as placing junctions, connecting pipes, and entering pipe and
junction properties. Refer to the Flow Through an Orifice example in
Chapter 2 for more information on these topics. To model the heat
transfer in these examples, the user may need to refer to Chapter 3 for
more detailed explanations.
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Model file

This example uses the following files, which are installed in the
Examples folder as part of the AFT Arrow installation:

»  Process Steam System.aro (GSC Scenario) — AFT Arrow model file

This example is provided in the model file under the English Units
scenario. It is also provided in metric units under the Metric Units
scenario.

Problem statement
A process steam supply system has two boilers at 300 psia, and 800 deg.
F.

All of the pipes in the system have 2 inches of insulation with a thermal
conductivity of 0.02 Btu/hr-ft-R, and an external convection coefficient
of 5 Btu/hr-ft2-R. The ambient temperature is 75 F. The pipes are all
Steel — ANSI, STD (schedule 40). All of the elbows in the system are
Smooth, with an r/D of 1.5.

Assume "Redlich-Kwong" for the equation of state model, and
"Generalized" for the enthalpy model. All of the tees in the system
should be modeled using the Detailed loss model, with sharp edges.

The system has six users with variable peak flow demands.
e User #1: 40,000 Ibm/hr
e User #2: 50,000 Ibm/hr
e User #3: 60,000 Ibm/hr
e User #4: 55,000 Ibm/hr
e User #5: 40,000 Ibm/hr
e User #6: 60,000 Ibm/hr

GSC Example

For the specified design flows, the process steam system must meet a
minimum delivery pressure of 100 psig at each discharge.
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Step 1. Start AFT Arrow

From the Start Menu choose AFT Products and AFT Arrow.

Step 2. Specify solution control

There is an option available in Solution Control when using one of the
marching methods that can sometimes result in an overall reduction in
solution runtime. This option is to first solve the system using the
Lumped Adiabatic method and then use these results as a starting point
for the marching solution. Since the Lumped Adiabatic solution can
typically be obtained much faster, this can provide an overall reduction
in runtime for the marching method.

To activate this option, do the following:

1.
2.

Open the Solution Control window

On the Solution Method tab, select the “First Use Lumped Adiabatic
Method to Obtain Initial Stating Point For Marching Solution”
option

Click OK to close the window

Step 3. Specify system properties

1.

S koW

Open the System Properties window by selecting System Properties
in the Analysis menu

On the Fluid Data Tab, select the AFT Standard database, and then
select "Steam" in the fluids available window

Click "Add to Model" to select steam for use in this model
Select the "Redlich-Kwong" Equation of State option
Select the "Generalized" Enthalpy model

Click the OK button
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Step 4. Build the model

A. Place the pipes and junctions

At this point, the first two items are completed on the Checklist. The next
Checklist item is to “Define Pipes and Junctions”. In the Workspace
window, assemble the model as shown in Figure 5.1.
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Layout of pipe system for Process Steam System
Example

Figure 5.1

B. Enter the pipe data

The system is in place, but now you need to enter the input data for the
pipes and junctions. Double-click each pipe and enter the following data
in the Properties window (or use the Global Pipe Editing window, as
discussed in Chapter 3):
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All of the pipes are Steel - ANSI with standard roughness:

Pipe Length | Nominal Size
(feet)

P1 100 12 inch

P2 150 12 inch
P10 75 12 inch
P101 400 8 inch
P102 750 8 inch
P103 750 8 inch
P104 250 8 inch
P105 100 6 inch
P106 50 6 inch
P107 75 6 inch
P201 250 8 inch
P202 500 8 inch
P203 500 8 inch
P204 500 8 inch
P205 50 6 inch
P206 75 6 inch
P207 50 6 inch

Enter the following data on the Heat Transfer tab for each pipe:

1
2
3
4.
5
6

Heat Transfer Model = Convective Heat Transfer
Ambient Temperature = 75 deg. F

Number of Insulation Layers = 1 External
Insulation #1 Conductivity = 0.02 Btu/hr-ft-R
Insulation #1 Thickness = 2 inches

External Convection Coefficient = 5 Btu/hr-ft2-R
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C. Enter the junction data

J1, J2 Tank Junctions
1. Elevation = 0 feet

2. Pressure = 300 psig
3. Temperature = 800 deg. F

J106, J107, J108, J206, J207, J208 Assigned Flow Junctions
1. Elevation = 0 feet

2. Flow Rate = see Problem Statement

J102, J105, J202, J205 Bend Junctions
1. Elevation = 0 feet

2. Type = Smooth Bend
3. Angle =90 deg.
4. /D=1.5

Note: The arrangement of the pipes on the Detailed tee junctions is
important because the branch pipe must be correctly designated.
Note that the two straight pipes can be assigned as either (a) or (b) in
the Tee/Wye Properties window without affecting the results.

J101, J103, J104, J201, J203, J204 Tee Junctions
1. Elevation = 0 feet

2. Loss Model = Detailed
3. Type = Tee (Sharp, Straight Run)

4. Arrangement = First Straight pipe (a), Second Straight Pipe (b),
Branch Pipe (c). (For example for J103, set (a) = P102, (b) = P103,
and (c) = P105.)

5. [Initial Pressure = 100 psig (on Optional Tab under Initial Guesses)

Note: Sometimes adding initial guesses to pipes or junctions can help
difficult solutions converge.
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D. Check if the pipe and junction data is complete

Turn on “Show Object Status” from the View menu to verify that all the
necessary data is entered. If all data is entered, the “Define Pipes and
Junctions” Checklist item on the Quick Access Panel will have a check
mark. If not, the uncompleted pipes or junctions will have their number
shown in red. If this happens, go back to the uncompleted pipes or
junctions and enter the missing data. You can also open the Undefined
Objects list from the View menu by clicking on “List Undefined
Objects...” to see what data is missing.

GSC Problem Statement

Use the Goal Seek and Control module to determine the supply pressure
required to deliver steam at a minimum discharge delivery pressure of
100 psig for each user.

GSC Step 1. Create a scenario for GSC case

Create a new scenario from the Base Scenario for the GSC Case. Refer to
Chapter 3 for directions on how to add a scenario.

GSC Step 2. Activate the GSC Module

Activate the GSC Module by choosing Activate Modules from the Tools
menu and selecting the GSC Module in the list.

Though the module is activated, you have the option to use or ignore it.
This is helpful if you want to check the impact of changes in your system
configuration or in troubleshooting the model without solving for the
variables. For the module’s features to be used in the simulation
calculations, select Goal Seek & Control from the Analysis menu and
then select Use (Figure 5.2)
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Figure 5.2 Select “Use” from the Goal Seek & Control menu item
on the Analysis menu to instruct AFT Arrow to perform
goal seeking when it runs

GSC Step 3. Open the Goal Seek and Control Manager

When the GSC Module is activated, Specify Goal Seek and Control
appears as an additional Checklist item.

The Goal Seek and Control is specified by entering data for variables and
goals in the Goal Seek and Control Manager window. Open the Goal
Seek and Control Manager from the Analysis Menu. After opening the
Goal Seek and Control Manager, the user specifies all of the system
variables, as well as the desired goals. The Goal Seek and Control
Manager is shown in Figure 5.3 below.

GSC Step 4. Add the variables

In the GSC module, variables are the parameters that AFT Arrow will
modify in order to achieve the specified goals. To obtain a unique
answer, there should be one variable applied for each goal. You may
define as many variables and goals as you wish.

Select the Variables tab on the Goal Seek and Control Manager window.
The Variables tab allows users to create and modify the system variables.
On the Variables tab, you are able to select the object and junction types,
the name and number of the object to which the variable applies, and the
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object parameter that is to be varied. Additionally, you can elect to apply
certain variables while omitting others.

Goal Seek and Control Manager

Variables | Goals  Mumerical Contral

‘&
New Variable

| Parameters to vary in orderto reach goals

T ® &
Duplicate Variable | | Delete Variable | | Delete All Variables

A tone | et | ]S 9181
o [ews | [ ke |

Figure 5.3 The Goal Seek and Control Manager is used to define
GSC Variables and Goals

For this example, we want to find the supply pressures that will give us a
specific minimum discharge pressure. Select the “New Variable” button,
and input the following variable data:

Apply: Checked
Object Type: Junction
Junction Type: Tank

Variable Parameter: Pressure
Link To: (None)

1.
2
3
4. Junction Number and Name: J1 (Boiler #1)
5
6
7. Lower and Upper Bounds: Leave blank
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The Apply column allows users to specify which of the variables that
have been defined will be used. This allows the flexibility of creating
multiple variable cases, while only applying selected variables for any
given run.

The Link To column allows users to apply the same variable to multiple
objects. This allows users to force parameters for several objects to be
varied identically.

Upper and lower bounds provide logical extremes during the goal search.

Linking variables

This process steam system has two boilers to supply steam to the users.
We have defined a variable for the first boiler, but we have not yet
accounted for the second boiler.

For this example, the discharge pressures will be defined as a single
Group Max/Min goal (see Step 5). However, if we define the second
boiler as another independent variable, this would create only one goal
for two variables.

To solve this issue, we will use variable linking. Variable linking allows
you to tie multiple variables together, forcing them to be the same. To
accomplish this, we will add a constraint to the problem that both of the
boiler supply pressures must be the same.

Select the “New Variable” button to add the variable for the second
boiler. To implement variable linking, specify Boiler #1 (J1) in the Link
To column of the Boiler #2 (J2) variable. Enter the data as shown below.

1. Apply: Checked

Object Type: Junction

Junction Type: Tank

Junction Number and Name: J2 (Boiler #2)
Variable Parameter: Pressure

Link To: J1 (Boiler #1)

AN i

7. Lower and Upper Bounds: Leave Blank

After entering the data, the Variables tab should appear as shown in
Figure 5.4.
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Goal Seek and Control Manager
\ariables Goals Numerical Control
u X & Farameters to vary in order to reach goal
Mew Variable Duplicate Variable Delete Varable Delete All Variables e g
Apply Object Type Junction Type Object Number ariable Link To Lower Bound Upper Bound
and Name Parameter (Optional) (Optional)

1 Junction ~ | Tank » | J1 (Boiler #1) |~ | Pressure |» | (None) ~
2 Junction w | Tank w | JZ2 (Boller#2) |« | Pressure |+ J1 (Boiler #1) |~

Figure 5.4 GSC Variables are parameters that are changed by AFT
Arrow to achieve the defined goals

GSC Step 5. Add a goal

Goals are the parameters you want to achieve. The goals are achieved as
AFT Arrow modifies the variables. To obtain a unique answer, there
should be one goal applied for each variable. You may define as many
variables and goals as you wish.

Select the Goals tab on the Goal Seek and Control Manager window. The
Goals tab allows users to create and modify the system goals. The goal
type, object type, and the goal parameter are selected. A criterion for
determining if the goal has been met is then specified, along with a value
and units for the goal parameter. The user then selects the object to
which the goal applies and, if applicable, the location on the object at
which the goal applies (e.g., the inlet or outlet of a pipe object).

For this example, we will be using a Group Max/Min goal. This type of
goal allows a single goal to be applied to a group of objects. Arrow
applies a Group Max/Min goal by ensuring the final goal value is either
greater than or equal to (Min) or less than or equal to (Max) the specified
value.

For our example, a Group Max/Min goal will be applied to ensure the
minimum discharge pressure at all of the assigned flow junctions is at
least 100 psig.

Define a group

In order to use a Group goal, the objects that the goal applies to must be
added to a Group. For detailed information about Groups, see the AFT
Arrow Help system.
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To create a group, select the Groups | Create option from the Edit menu
(note: you will have to click OK on the GSC Manager window to be able
to access the menu items). When prompted, give the new group a name,
such as "Users", and select OK. Alternatively, you can select the
Assigned Flow junctions on the Workspace before creating the groups
and they will be pre-selected when the group is created (note: you can
select multiple objects at the same time by holding SHIFT as you select
each object).

After naming the new group, the Group Manager will be displayed.
Select the new group name from the list, and then select all of the
assigned flow junctions from the junction list, as shown in Figure 5.5.
After choosing the assigned flow junctions, select the OK button on the
Group Manager window.

Group Manager X
Existing G E
I e Filter Options
Create Group.
(8) All Fiters Change Together
Rename Group () Filters Work Independently
Delete Group
Pipes in Group Junctions in Group Subgroups in Group
11 Fipe ~ 11 Boiler #1 (Tank) ~
Oz Pipe 12 Boiler #2 (Tank)
[]10 Pipe []101  Teeor Wye
[]101  Pipe []102 Bend
[]102  Fipe []103  TeeorWye
[]103  Pipe []104  Teeor Wye
[]104  Pipe []105 Bend
[]105 Fipe [#] 106 User #1 {Assigned Flow)
[]106  Pipe [#] 107 User #2 {Assigned Flow)
[]107  Fipe [] 108 User #3 (Assigned Flow)
] 20 Pipe ] 2m Tee or Wye
[]202 Pipe []202 Bend
[]203 Pipe []203  TeeorWye
[]204 PFipe []204 TeeorWye
[1205 Fipe []205 Bend
1206 Pipe v [] 206 User #4 {Assigned Flow) v
Al || Mone | Invert | Workspace | Special Al | None | Invert || Workspace | Special... Al | None | Invert
| Selected: 00f 17 5 selected: 6of 18 | Selected: 00f 0
Cancel Help

Figure 5.5 Groups are created using the Group Manager

Add a Group Max/Min goal

Now that the group has been defined, reopen the Goal Seek & Control
Manager window, and select the Goals tab. Add a new Goal by clicking
the New Goal button, and entering the following goal data:

1. Apply: Selected
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Goal Type: Group

Object Type: Group Max/Min

Goal Parameter: Pressure Stagnation
Criteria: >=

Goal Value: 100

Goal Units: psig

Object ID: Users

Object Location: NA

A S AT O e

After entering the data, the Goals tab should appear as shown in Figure
5.6.

As variables and goals are added to a model, AFT Arrow will display
symbols beside the pipes and junctions that have variables or goals
applied to them. The default is a “V” for variables, and a “G” for goals.
This is illustrated in an example Workspace (not of this example model)
shown in Figure 5.7.

The goal symbol is not displayed next to objects that are part of a group
goal, so you will see only the “V” displayed on the Workspace for this

example.
Goal Seek and Control Manager
Variables Goals MNumerical Control
T X & Desired goals in Output
MNew Goal Duplicate Goal Delete Goal Delete All Goals S A
Apply Goal Type Object Goal Criteria Goal Goal Object CObject
Type FParameter Value Units D Location
1 Group ~ | Group Max/Min |~ | Pressure Stagnation |~ == |=| 100 psig |~ | Users |~ | NA

Figure 5.6 GSC Goals are the parameter values set by the user that
AFT Arrow adjusts the variables to achieve

GSC Step 6. Run the model

Select “Run Model” in the Analysis menu. This will open the Solution
Progress window. This window allows you to watch as the AFT Arrow
Solver converges on the answer.
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Note: When using the GSC module there is a new area displayed in
Solution Progress that shows the specific progress of the GSC module.
As it makes progress, the Best (Lowest) value will decrease towards
zero. The field in the far right displays how many complete hydraulic
solutions have been run.

After completion click the Output button at the bottom of the Solution
Progress window.

i Workspace | §9 Model Data = Output | [2 Graph Results | % Visual Report

D Hints | e~ | @ ~(%x M |&l=|og AR
< oo - ~
- 22

"V" symbol for
O [ ;

a GSC variable

> @ 1
1

gL J1 . V2
I S W

[=]
2o T
TTGTT < ]}01

0o =3 for a [;;g;]:lgoal

If o v

< >
Base Scenario I:al::{ 100% |l%l [ "E-'I -1 (@2

Figure 5.7 AFT Arrow displays symbols next to objects on the
Workspace that have goals or variables defined
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GSC Step 7. Examine the results

The Output window contains all the data that was specified in the Output
Control window. The results of the GSC analysis are shown in the
General Output section.

The GSC Variables tab shows the final values for the variable
parameters, as shown in Figure 5.8. The GSC Goals tab shows the values
achieved for the goals, as shown in Figure 5.9.

GSC analysis summary

The GSC module analysis determined the supply pressure required to
deliver a minimum pressure of 100 psig at all of the users is 298.8 psig at
the boilers. Note that, because the variable for the J2 Boiler pressure was
linked to the J1 Boiler variable, the final variable results for both are
identical.

General Warnings  Tank Summary = GSCVariahles | G5C Goals

. Object Object Parameter | Value | Units
Variable | Type

1 Tank  J1 (Boiler #1) Pressure 2538 psig
2 Tank  J2 (Boiler #2) Pressure Z98.8 psig

Figure 5.8 The final GSC Variable values are shown on the GSC
Variables tab in the Output window General section

General Warnings  Tank Summary  GSCVariables = G5C Goals

Goal Object Object ID | Object Parameter User Goal | Actual Goal | Units | Object Used
Geal Type Type Location Value Value for Group Goal
1 |Group Group Max/Min  Users /A Pressure Stagnation 100 100.0 psig  J108 (User ¥3) |

Figure 5.9 The final GSC Goal values are shown on the GSC Goals
tab in the Output window General section. The Actual
and User values should be close if GSC was succesful.
If not, a warning will appear.
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CHAPTER 6

Other AFT Arrow Capabilities

This Quick Start Guide necessarily omitted coverage of a number of
AFT Arrow capabilities. This chapter briefly describes some of the
important capabilities not covered.

Microsoft Excel™ data integration

AFT Arrow now includes enhanced Excel importing and robust Excel
exporting. An Excel spreadsheet can be used to vary selected input
parameters in multiple scenarios. Selected output can also be exported to
specified Excel sheets and cells.

Integration with other software and data standards

AFT Arrow includes a number of importing and exporting capabilities.
Piping layouts and dimensional data can be imported from GIS
Shapefiles (SHP) to build a model. Additionally, CAESAR II Neutral
Files (CII) can be imported into AFT Arrow and EPANET Files (INP)
can be both imported and exported.

Piping Component Files (PCF) from AutoCAD Plant 3D, SmartPlant,
PDS, CADWorx, and other software can be imported into AFT Arrow.
These options are all accessed from the File Menu.

Gas mixtures using NIST REFPROP and Chempak

NIST REFPROP and Chempak support gas mixing in two forms. First,
users can create their own mixtures. These are called pre-mixtures
because they are defined before the model is run. Second, as flow
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streams of different composition mix, an entirely new gas mixture
results. Its composition depends on the composition of the incoming
streams as well as the relative flow rates. Since in general the flow rates
are not known by the user, AFT Arrow updates the composition of this
new mixture as the simulation progresses. For this reason these mixtures
are referred to as dynamic mixtures. AFT Arrow is restricted to non-
reacting gas mixture calculations.

The ASME Steam Tables database

The ASME Steam Tables Database offers users access to fluid properties
obtained from the IAPWS Industrial Formulation 1997 for the
Thermodynamic Properties of Water and Steam (ISPWS-1F97). This
database is selected by choosing the option at the top of the System
Properties window, at which point it is automatically displayed in the
Fluids in Current Model area.

Separator junction

Fitting library

AFT Arrow supplies a separator junction. This junction type allows you
to separate fluids out of a mixture. Since mixtures can only be modeled
using Chempak, this junction requires Chempak.

AFT Arrow offers a library of about 400 fitting losses that can be added
to pipes.

Network databases

Junction components and pipe materials can be saved to databases for
later reuse. Databases can be located on local PC's or deployed across
local or wide area networks. The Database Manager allows users to
connect to relevant databases for their specific pipe system design.

Varied pipe geometries including rectangular duct

Five different pipe geometries can be modeled in AFT Arrow. The
default geometry is the cylindrical pipe. The other four geometries are
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rectangular duct, cylindrical annulus, noncylindrical pipe, and helical
tube.

Sonic choking

AFT Arrow models sonic choking in complex pipe systems and
accurately predicts the resulting choked flow rate. In addition, AFT
Arrow can accurately calculate multiple choking points in the system.

Rotating systems for turbomachinery

AFT Arrow allows users to specify rotational velocities such as those
experienced in turbomachinery. AFT Arrow uses this information to
determine the varying acceleration body force on each individual pipe as
determined by the laws of rotational dynamics.

Elevation changes

AFT Arrow uses elevation differences between junctions to calculate
hydrostatic or gravity pressure changes in a system. This can be
especially useful for high density gases with moderate elevation changes,
pipe systems with significant elevation changes such as those found in
overland natural gas pipelines, and gas piping for deep mining
operations.

Relief system modeling

AFT Arrow provides support for modeling relief systems, including
relief valve junctions and support for ANSI/ISA Cv loss coefficients.
Sonic capabilities allow modeling of high velocity conditions often
found in relief systems.

Control valve modeling

AFT Arrow can model four types of control valves. They are Pressure
Reducing Valves (PRVs), Pressure Sustaining Valves (PSVs), Flow
Control Valves (FCVs), and Pressure Drop Control Valves (PDCVs).



96 AFT Arrow 7 Quick Start Guide

Variable speed compressors and fans

AFT Arrow allows you to model controlled compressors or fans where
the control parameter is flowrate, discharge, or suction pressure. The
compressor or fan speed is varied to deliver the flow rate or discharge
pressure you set.

Heat of compression

AFT Arrow allows users to choose several different compression models
for compressor junctions. The compression process models how the heat
of compression affects the gas temperature, which is especially important
in compressor applications.

Insulation on inside of pipe/duct
Insulation can be placed on the inside of a pipe or duct, and the effect of
reduced flow area on the pressure drop will be automatically determined.

If modeling heat transfer, the effect of the insulation on the inside will be
accounted for.

Data varied through Microsoft Excel™

You can use an Excel spreadsheet to vary selected input parameters.

Model heat transfer between loops

Heat transfer between loops which are hydraulically isolated can be
modeled. The loops can have different fluids. This is called thermal
linking.

View input and output data from different scenarios concurrently

Input data from different scenarios can be viewed concurrently in the
Model Data window. Similarly, output data from different runs can be
viewed concurrently in the Output window.
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Design Alerts

Design Alerts for one or more parameters can be entered for a pipe. A
common use is maximum and minimum allowed operating pressure. If
the resulting value for that parameter violates the Design Alert a warning
message is given in the output.

Cost calculations

Material, Installation and Maintenance costs can be calculated for
junctions, pipes and fitting based on Cost Databases which are user-
created. In addition, energy (operation) costs can be calculated for
compressors/fans. Time value of money can be taken into consideration
by entering inflation and interest rates. The results are presented in a
Cost Report in the Output.

Retaining graphs

Comprehensive graphing features allow users to graph a wide variety of
parameters at single points or along flow paths within their model.
Graphs added to a Graph List are saved so that the graph can be
regenerated if changes are made to the model input, or if the user desires
to plot the same graph in multiple scenarios. Multiple graphs can be
shown at the same time.
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